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PREFACE

The 71ýchnology Benefits Model tool is a spreadsheet implementation of various models for estimating
the effect on the cost of software development due to using some new technology in the software
development process.

The 1iechnoloey Benefits Model tool was designed to provide estimates on the impact of one or more
technology capabilities :n a software development organization. The model provides these estimates
for a period oftinme u,, 15 years. The estimates are provided in terms of the impacts on several cost
measures, including. unit costs. and the total costs to develop a software system of some given size.
The tool provides both spreadsheet and graphics capabilities. It requires the use of Microsoft Excel,
version 4A), and can operate on either a Macintosh or an IBM-compatible PC.

You can use the &lihnology Benefits Model tool to help you estimate the potential effect of a
technoiogy on the cost of conducting each development activity, such as requirements analysis, prelim-
inary design, or detailed design. The tool will enable you to see the impact of such estimates over a
number of years. You can use the Technology Benefits Model tool to estimate the effect on unit labor
rate, unit labor cost, product development cost, market cost, and market cost savings due to
incorporating some new technologies into the development process. Please be aware that the model
implemented in this tool is at an early level of validation.

The tool computes cost estimates for the following scenarios:

"* Without application of the technology

"* With application of the technology, with the intended extent of use in the target organization

• With application of the technology, with 100% extent of use in the target organization

The estimates of unit labor cost, unit labor rate, product development cost, market cost, and market cost
savings implemented in the Technology Benefits Model tool are just that-estimates. Mathematics cannot
make estimates into certainties. It is very important for you, as the user of this tool, to note that the results
of its application can be no better than the data you provide.
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1. INTRODUCTION

1.1 OVERVIEW

This document is the user manual for the Technology Benefits Model tool, which provides automated
support for performing economic analyses of the benefits of using various technologies. The tool pro-
vides a framework for you to analyze the economics of introducing new technology into your software
development organization or making process improvements. The tool is implemented on version 4.0
of the Microsoft Excel spreadsheet. You can operate it using either an Apple Macintosh or an
IBM-compatible PC. It provides both spreadsheet and graphics capabilities.

Section 2 describes the operations provided by the tool and summarizes the model. You should
become familiar with this section before using the Technology Benefits Model tool to use it with
maximum effectiveness.

1.2 BACKGROUND

Technology change is worthwhile only if it leads to software development process improvement. The
principal management variables that are affected by improving the software development process are:

"* Size (for a given functionality)

"* Cost

"• Schedule

"• Quality (indicated by defect content)

Improvement should be indicated (measurable) over time by reduced:

"* Variation in any one or all of these variables

"* Average of any one or all of these variables

Improvement can also be indicated by an enhanced accuracy of estimation. The Technology Benefits
Model focuses on the cost variable. Technology impact is entered into the model in terms of reductions
in unit cost of overall development process or of one or more development activities (e.g., design) over
time. Schedule impact is not calculated by the Technology Benefits Model but can be derived from
the calculated cost impact. The Technology Benefits Model computes savings as the difference be-
tween product development costs with and without the technology change. Also, you can use the sav-
ings calculated by the tool to calculate the return on investment (ROI) resulting from the use of some
new technology described in Section 4.4. The tool does not calculate the ROT for you, however. The
input parameters that you select and the tool outputs are identified in Section 2.4.
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1. Introduction

1.3 AUDIENCE AND PURPOSE

The Technology Benefits Model tool is designed for those persons, such as business area managers
and supportive technology analysts, who are interested in evaluating technology insertion opportuni-
ties. You can use the Technology Benefits Model tool to help you analyze the potential impact of adopt-
ing various technologies on the overall cost of software development. The tool enables you to examine
the effects on the software product development cost of varying certain parameters, such as the unit
labor cost, the unit labor rate, the impact, the coverage, and the extent of new technology use.

1.4 MANUAL ORGANIZATION

This manual describes how to use the Technology Benefits Model tool. It illustrates some of the ways
you can analyze the potential impact of adopting various technologies on the overall cost of software
development. The main body of the manual is organized as follows:

"* Section 2, Benefits Analysis Process, summarizes the operation of the tool and the model it
implements.

"* Section 3, Invoking the Tool, describes how to install and open the Technology Benefits Model
tool.

"• Section 4, Operating the Tool, describes the menu bar selections and windows presented
during tool operation. Also, various examples of the tool's use are described.

"* Section 5, Case Studies, describes some user experiences with the tool.

Appendix A, Technology Benefits Mathematical Models, presents the models implemented in the
Technology Benefits Model tool.

.'-- List of Abbreviations and Acronyms contains all the abbreviations and acronyms used in this
manual with their definitions.

The Glossary section provides definitions of terms used in this manual.

The References section identifies sources of additional information.

1.5 TYPOGRAPHIC CONVENTIONS

This manual uses the following typographic conventions:

Serif font ......................... General presentation of information.

Italicized senif font ............... Publication titles.

Boldfaced serif font .............. ! ýction headings and emphasis.

[ I ............................... Screen buttons.

< > ............................ Workstation key ,oard key names, such as < RETURN >
for the Return key.
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2. BENEFITS ANALYSIS PROCESS

2.1 SECTION OVERVIEW

This section describes how you can use the Technology Benefits Model tool to aid you in estimating
the potential savings in the costs of developing software that will be realized in your organization from
using some new technology (such as an improved method for doing design) or making some process
change. The tool should be useful to help you answer various questions relating to the potential impact
of some technology on the productivity of your development organization. This section answers some
of these questions. Often, there is little actual data about the impact of a technology for you to work
with. However, you will probably be able to make educated guesses, based on your engineering judg-
ment and experience, about the potential effect of a technology on the cost of doing some development
activity, such as detailed design. The tool will enable you to see the impact of such estimates over a
number of years, thus helping you to make a better determination as to whether these estimates feel
right or appear sensible. The tool provides five different graphs, each of which provides an analysis
support capability. This section summarizes those capabilities.

2.2 TOOL OVERVIEW

You can use the Technology Benefits Model tool to estimate the effect on unit cost, unit labor rate,
product development cost, market cost, and market cost savings due to incorporating some new tech-
nology into the development process, as described further in Section 2.4. The tool estimates the reduc-
tion of software costs resu".'ng from applying one or more technologies (up to nine) in a software
development process for periods of time up to 15 years. A technology could be a computer aided soft-
ware engineering (CASE) tool or some new verification technique. It could be some new approach
to developing requirements. In this case, using che technology might increase the unit cost of develop-
ing requirements and might also reduce the unit cost of testing (due to a reduction in the number of
defects found and rework required. attributable to the use of the technology). You can specify the ex-
tent of use of each technology in your development organization. The tool enables the effect of each
new technology to be considered on the (expected) cost of the development process overall or on the
individual (up to 12) activities that constitute it. It can reflect the effect of a learning curve on the sav-
ings impact of use of a technology. Initially, the savings might be minimal or even negative and then
might increase in subsequent years as the members of the development organization become more
adept in the use of the technology.

You can represent the effects on the costs of each of the principal software development activities (for
example, those defined by DOD-STD-2167A) of applying one or more new technologies because you
have baseline figures for the proportion of the development effort in each of the activities. The tool
provides default values for the figures for the activities that constitute the software development pro-
cess described in DOD-STD-2167A. You can replace these values or select a different set of
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2. Benefits Analysis Process

development activities. You can enable or disable each of up to nine technologies so that you can
investigate the effect of any one or a combination of them. Also, you can consider the effect of using
many technologies by lumping them together. Additionally, you can model the situation in which dif-
ferent technologies are phased into use at different times over a period of up to 15 years that can be
considered with the tool.

You can use the tool to compare the costs of development without the technology with the costs to
be expected when the technology is employed. The savings to be expected when the technology is
employed at a specified extent of use in an organization can be compared with the savings expected
when the technology is applied at a 100% extent of use. The 100% extent of use case is portrayed as
one curve in each of the five sets of trend curves (see Section 2.4 ) that the tool can provide. The tool
can represent the overall effect on development costs due to factors in addition to those represented
by the technologies under explicit consideration in a model use scenario. For example, a reduction
of development unit labor rate in labor months per thousands of source lines of code (LM/KSLOC)
of 3% per year might be expected. The tool can represent this situation. The tool can also model the
increase in thousands of dollars (K$) per labor hour or month over the period of time considered. For
example, an increase in the hourly labor cost of 4% per year might be expected. Such a cost increase
should be more than covered by a productivity increase (unit cost reduction) over the period of inter-
est. Doing so is a prime reason for investment in technology; the Product Development Cost vs Time
or the Market Cost vs Time graph of the tool (see Section 2.4) can be used to demonstrate such effects.

2.3 MODEL STRUCTURE OVERVIEW

The model equations show the reduction in development costs to be achieved through the use of up
to nine technologies. The equations represent these effects over a range of up to 15 years. For each
of these years, the proportion of cost savings is determined by summing the savings due to each tech-
nology. Each of these values of savings is the product of the following factors impact, extent, and
coverage. These factors are defined as follows:

1. Impact. Net percent development labor reduction (or savings) in a portion of the development
cycle due to the use of a particular new technology.

2. Extent. Percent of customer development organization using a particular technology.

3. Coverage. Percent of development cycle labor to which a particular technology is applicable.

An impact factor is given for each of the technologies for each of the development activities to which
it applies. Initially, in a given development activity (such as preliminary design) there may be a net
cost and, subsequently, a net savings due to the use of a technology. Also, in a given year, there may
be a net savings in one development activity and a net cost in another development activity.You should
select values of the impact parameter based on an assessment of the process currently used by your
organization and of the nature the new technology. For example, if the process currently used by your
organization is relatively immature, a new technology would be expected to have a higher degree of
impact than if your organization were more mature. if your organization is currently using a very good
method and supporting tools to develop requirements then, introducing a new technology might not
have a very high impact. However, if your organization's approach to requirements development were
very primitive, then the introduction of a new requirement to the new technology might have a substan-
tial impact. You may not be certain of the exact values of the impact to use for the effect of a technology
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2. Benefits Analysis Process

on development cost. You might accommodate this by applying the tool several times and using several
values of the impact that would cover the upper and lower ends of the range of values that seem reason-
able to you. The coverage factor is related to the development activity profile for the organization
whose costs are of concern. The extent factor is the proportion of the organization at issue that is going
to use the technologies. This factor weights the effect of use of a technology based on the degree to
which it is employed in an organization.

The basic equations of the mod.l build from this form:

Unit Labor Rate = (Base Labor Rate). 1 - %Savings - %Savings
100 year) 100 year2

Note that the effect of applying a technology is multiplicative. Thus, in the first year of application
of the technology, the unit labor rate (in LM/KSLOC) is equal to a factor less than one times the base
labor rate, provided that the savings factor is positive. In the second year, the unit labor rate is equal
to the product of two such factors, one for each year, times the base labor rate. For example, if tile
base labor rate were 10 LM/KSLOC and the first and second year savings or impact proportions (due
to the application of some technology) were 0.05 (or 5%) for the first year and 0.05 (or 5%) again for
the second, then the first year unit labor rate would be 9.50 LM/KSLOC and the second year unit labor
rate would be 9.03 LM/KSLOC. Note that the law of diminishing returns is represented here. A 5%
savings impact due to the application of technology results in a labor rate reduction of 0.50 LM/
KSLOC in the first year but one of 0.47 LM/KSLOC in the second year.

To gain an appreciation for the meaning and use of these factors, consider this example. Suppose
Technology X is targeted to the design activity. Assume that design activity initially comprises 20%
of the process labor rate. Further, suppose that, if applied, Technology X would save 10% of the cost
of design. In addition, suppose that only 50% of the organization in question will use the technology.
In this case, the application of Technology X would result in a savings of 1% of the development pro-
cess overall (20 x 10 x 50 x 0.000001 = 0.01) (see Appendix A). Alternatively, the development process
would cost 99% of what it would without the application of the given technology.

2.4 SELECTING THE RIGHT GRAPH

The Technology Benefits Model tool provides five graphs to help you determine the answers to various
questions. such as those indicated in Section 2.5. The graphs are:

1. Unit Labor Rate vs Time

2. Unit Labor Cost vs Time

3. Product Development Cost vs Time

4. Market Cost vs Time

5. Market Cost Savings vs Time

Each of the first four graphs consists of three curves:

1. Without application of technology

2. With application of teclhology, with user-entered extent of use

3. With application of tcchnology, with 100% extent of use
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2. Benefits Analysis Proces

The fifth graph, Market Cost Savings, consists of two curves:

1. Savings due to use of technology, with user-entered extent of use

2. Savings due to use of technology, with 100% extent of use

In addition, the tool calculates two sets of values of Product Development Cost Savings:

1. Savings due to use of technology, with user-entered extent of use

2. Savings due to use of technology, with 100% extent of use

The tool does not plot this data. However, it provides the data to you on its spreadsheet.

Table 2-1 cites the inputs that you must provide to obtain each of the graphs. Table 2-2 summarizes

the application of each of the graphs or capabilities cited above.

Tahle 2-1. Model Input Parameters

Graph Number

Input Parameter Description 1 2 3 4 5

1. Baseline (first year) unit labor rate (LM/KSLOC). P. P, PI I P-,"

2. Percent annual labor rate decrease not due to technology po ;0 P, 1-10, j-,,

whose impact is being modeled. It represents productivity
improvements attributable to the maturation of the organi-
zational process or methodology improvement not attrib-
utable to the technology under consideration. A positive
value indicates a rate decrease (decreased costs). A nega-
tive value indicates a rate increase (increased costs).

3. Baseline (first year) unit labor cost (K$/LM). t- j,-" ." /-

4. Percent annual wage increase. A positive value indicates " -0," P-0 pl"
wage growth. A negative value indicates wage shrinkage.

5. Size of product in KSLOC. This is the size of a product to
be developed in each year of the scenario.

6. Baseline market size in KSLOC. This is the amount of
unique code to be developed.

7. Market size annual percent growth rate. A positive value t-1 t,,
indicates market growth. A negative value indicates.mar-
ket shrinkage.

8. The first year (e.g., 1993) of the 15 years that the tool will ' ;0 P. 1,, t-1
consider in this technology application scenario. This esta-
blishes the window into which the extent (see parameter
10) and the impact (see parameter 11) for each technology
considered must fit.

9. Coverage, percent of development process effort applied p,, P,, P,, P- Po
to each of the (up to 12) activities that compose the devel-
opmcnt process. This parameter is fixed for the time inter-
val (up to 15 years in length) being modeled.*
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2. Benefits Analysis Process

'able 2-1, continued

Graph Number

Input Parameter Description 1 2 3 4 5

10. Extent, percent of user organization applying each tech- p. k1j P,," k#,' k..
nology (up to 9), for the start and end years of the time in-
terval (up to 15 years in length) being modeled.**

11. Impact, percent unit net cost reduction (net savings) due pow ;00 P,, ,, P1,
to applying each technology (up to 9), for start and end
years of the time interval (up to 15 years in length) being
modeled. A positive value is used to indicate a net savings.
A negative value is used to indicate a net cost. You provide
the start and end year impacts for every technology and ac-
tivity combination.**

Note that "coverage" is fixed in the model implemented in version 1 of this tool. It will be variable in a future version
to reflect changes in the distribution of effort over the development activities due to the continuing use of a new technol-
ogy over a number of years.
Note that the tool interpolates values for extent and impact for the years between the beginning and the end of the
time interval modeled from the values that you provide for the beginning and end years. It is important that you remem-
ber that the impact is compounded annually over the period of years that you select. The tool computes the percent
impact for each year by interpolating between the values for the start and end years that you provide. For example,
suppose that the extent for a technology is 100% at the start year and at the end year (and thus, for each year in between).
Also, suppose that you select, for each development activity, a start year impact value of 5% and an end year impact
value of 5% to cover a period of 10 years. Then, at the end of the 10-year period, the unit labor rate would be reduced
to 0.6 of the original value (as (1-0.05)10 = 0.9510 = 0.6).

Table 2-2. Graph or Capability Application

Graph or Capability Application

Unit Labor Rate vs Time You should use this graph when you wish to estimate the effect of
a technology on the unit labor rate (labor months or hours per
KSLOC) of your development organization over a period of time
of up to 15 years. Most desirably, this effect would be a reduction,
of course.
You can also use this graph to determine the proportion of change
(most desirably, reduction) in labor required over the period of time
considered. The proportion can be seen if you first set the value ot
the baseline unit labor rate equal to unity. Then, you would inter-
pret the tool output as a proportion (or, equivalently, a percent) of
the baseline value of one, that at the first year of the up to 15 years
that the tool can simulate.

Unit Labor Cost vs Time You should use this graph when you wish to estimate the effect of a
technology on the unit labor cost (K$/LM) of your development orga-
nization over a period of time of up to 15 years. Most desirably, this
effect would be a reduction, of course. Developing this graph requires
you to provide a baseline for the first year (up to 15 years can be consid-
ered) labor rate in K$ per month and an inflation rate, in addition to
the parameter values needed for the unit labor rate graph.

You might use this graph to do some "what if" studies to help you
to estimate thc amount of cost reduction you will need from an in-
vestment in new technology in order to offset the expected addi-
tional costs of software development that are expected due to wage
rate inflation over the period of years of interest.
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Table 2-2, continued

Graph or Capability Application

Product Development Cost vs Time You should use this graph when you wish to estimate the effect of
a new technology on the cost (K$) for your organization to develop
a software product of some size (KSLOC) over the period of years
you are considering up to 15 years. Most desirably, this effect would
be a reduction of cost. Developing this graph requires you to pro-
vide a size of the expected product in addition to the parameter val-
ues needed for the unit labor cost graph.
You can also use this graph when you estimate the effect of a tech-
nology on the LM that would be required for your organization to
develop a software product of some size (KSLOC) over a period of
up to 15 years. You would set the value of the parameter "Baseline
(first year) unit labor cost" equal to 1. You would also set the value
of the parameter "Percent annual wage increase" equal to 0. Then,
you would interpret the output of the Product Development Cost
graph as product development labor months, although it would be
labeled Product Development Cost.

Product Development Cost Savings vs You can use the tool to obtain values for the savings in dollars that
Time use of the technology in question is expected to save in connection

with the development of a product considered in the Product Devel-
opment Cost graph.There is no graphical presentation of the sav-
ings to be expected. The tool provides this information to you on the
spreadsheet associated with the Product Development Cost graph.

Market Cost vs Time You should use this graph when you wish to estimate the effect of a
technology on the cost (K$) for your development organization to de-
velop software to satisfy a market of some size. Developing this graph
requires you to provide a baseline figure (in KSLOC) of the market
size (demand) for the first year of the range of years in which you are
interested. Also, you provide an annual growth rate for the market,
expected to exist over the period of years you are considering, up to
15 years.
You can also use this graph to obtain another Product Development
Cost vs Time plot in addition to the one obtained using the Product
Development Cost vs Time graph as described earlier in this table.
You would set the value of the parameter "'Baseline market size"
equal to the size of the product whose development cost you are go-
ing to estimate. Also, you would set the value of the parameter
"Market size annual percent growth rate" equal to 0.

Market Cost Savirngs vs Time You should use this graph when you wish to estimate the amount
of savings in dollars you would realize in satisfying the market you
have specified (see the description of the Market Cost graph) that
the use of the technology will provide on annual basis.
You might use this graph to do some "what if" studies to help yon to
estimate the amount of cost reduction you will need from an invest-
ment in new technology in order to offset the expected additional costs
of software development that are expected due to market growth (and
wage inflation) over the period of years of interest. Ideally, a business
would be able to nullify the effect of such cost growth through the use
of new technology, thereby achieving a profit growth.

ROI You can calculate the return on your investment in technology
using the data on estimated savings for you by the tool. Also, you
must estimate the cost of the investment that you must make in or-
der to realize that savings. Then, you can calculate the estimated
ROI. This version of the tool does not calculate the ROI.
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2.5 TECHNOLOGY BENEFIT AND COST QUESTIONS

You can use the Technology Benefits Model tool to help answer various questions of interest when
you analyze the potential savings in the costs of software development that using some technology
might provide to your development organization. This section provides some of these questions and
answers them. Section 4 illustrates the operation of the tool, including the generation of the various
graphs listed in Section 2.4 and described in Table 2-2. Some of the questions that the tool can help
you to answer are:

1. What is the reduction in the unit labor cost of developing software that I should expect in my
organization if I introduce a new technology this year?

You can use the Unit Labor Rate vs Time graph to help you to answer this question. Table
2-2 describes the application of this graph, and Section 4.3.3.1 provides details about its opera-
tion and output. As noted in Table 2-1, you enter the Unit labor rate for the entire development
process (e.g., 10 LM/KSLOC) and the Percent annual labor rate decrease (e.g., 3) that you
expect to see during the up to 15 years of the technology application scenario that you are con-
ducting, starting with the first year (e.g., 1993), which you also enter. You also enter the percent
of the Unit labor rate for each of the (up to 12) development activities that you have identified.
Typically, each of these values, called the coverage, remains constant from scenario to scenario
because they are characteristics of your organization. The sum of the coverage values for the
individual activities must sum to 100%. You define the first year and last year values for the
extent and the impact for the technology whose effect on costs in your organization you wish
to investigate. The tool interpolates between the beginning and end year values that you enter
for each pair to compute the values for the intermediate (up to 13) years.

2. What is the proportion of reduction in the cost of developing software of a given size that I
should expect in my organization if I introduce a new technology this year?

You can use the Unit Labor Rate vs Time graph to help you to answer this question like
question 1. Refer to Section 4.3.3.1 to help you understand how to answer this question. Howev-
er, you set the value of Unit labor rate equal to 1 rather than the actual value (e.g., 10 LM/
KSLOC). You select the other parameter values as described in connection with answering
question 1. You interpret the Labor Rate vs Time graph values as proportions of its value (un-
stated) in the first year, the baseline figure. This capability can be very useful because it does
not require you to know your present (baseline) unit labor rate and also because it enables
you to focus on the change from the present cost situation of your organization to what it is
estimated to become over a period of years due to the introduction of use of some technology.

3. What is the likely reduction in the cost of developing a software product of a given size in
KSLOC in my organization if I introduce a new technology this year?

You can use the Product Development Cost vs Time graph to help you to answer this question.
Table 2-2 describes the application of this graph, and Section 4.3.3.3 provides details about
its operation and output. As noted in Table 2-1, you enter values for all of the parameters de-
scribed in connection with question 1 as well as three others: Baseline unit labor cost, Percent
annual wage increase, and Size of product. The Baseline unit labor cost is the cost of a labor
month of direct effort in K$ for the first of the up to 15 years that you can analyze in a scenario.
The Percent annual wage increase is the expected annual wage inflation rate that you expect.
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You are undoubtedly very interested in determining if the reduction in costs attributable to
the introduction of some particular technology is sufficient to counterbalance the wage infla-
tion rate. The Size of product could be the size of typical products developed by your organiza-
tion. You are probably interested in determining how the technology you are considering
applying in your development organization will affect the cost of developing products of that
size over a period of years.

4. What is the likely reduction in the cost of developing a software product of size (some number
of KSLOC) in my organization if I introduce several new technologies on a phased basis over
a period of (some number of) years?

You can use the Product Development Cost vs Time graph to help you to answer this question.
You enter the same data as you would to answer question 3. In addition, you enter the values
for extent and for impact for two or more technologies. Section 4.3.3.3 illustrates the situation
for the case of applying two technologies, one for requirements, starting in 1993, and the other
for design, starting in 1995. You can also use the Product Development Savings data presented
by the tool on a spreadsheet but not displayed on a graph to give you additional information.
You might have expected that the use of the new technologies would result in a savings in all
of the years being considered. In the example considered in Section 4.3.3.3, this is not the case.
In fact, during a 3-year period, the savings would be negative. Before that time and after it,
however, the savings would be positive. This situation in part results from the timing of the
introduction of the new technologies and the effects of the learning curve in their adoption.

5. What is the likely return on my investment of introducing several new technologies on a phased
basis over a period of (some number of) years in terms of reducing the cost of developing soft-
ware to meet a market (some size in KSLOC) this year that grows at an annual rate of (some)
percent over the next (some number of) years?

You can use the Market Cost Savings vs Time graph to help you to answer this question to
estimate the ROI. This will help you to estimate the savings that will result from the adoption
of new technology. You will separately have to estimate the yearly costs of introducing the tech-
nology into the organization. You will also need to know the cost of money or rate of annual
interest that you will use in calculating the ROI that is expected to result from introducing
this technology into your organization. The tool does not perform this calculation for you. Sec-
tion 4.4 provides the formula that you can use to do so and an example of applying it.

Table 2-2 describes the application of the Market Cost Savings vs Time graph, and Section
4.3.3.5 provides details about its operation. You enter the same data as you would to answer
question 4 except that you omit the Product size figure and, in its place, provide Baseline mar-
ket size and Market size annual percentage growth rate. The former is the initial size of the
market your organization intends to meet in the first year of the period of the scenario. The
latter is the rate at which you believe it will increase annually.
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3. INVOKING THE TOOL

The Consortium provides the Technology Benefits Model tool as a set of Microsoft Excel files on a
diskette. The tool will operate on either an Apple Macintosh or an IBM-compatible personal computer
(PC). A prerequisite for the operation of the tool is to have version 4.0 of Microsoft Excel installed
on your computer.

Microsoft Excel retains a list of recently opened files that display in the File Menu. Do not try to open
the Technology Benefits Model tool from this list. Attempting to open the tool from the recently
opened list may result in the error message "cannot find..." To recover from this error, click the IOK]
button. A Macro Error Dialog Box appears. Click the [Halt] button. Then select Quit from the File
Menu.

3.1 INSTRUCTIONS FOR THE MACINTOSH VERSION OF THE TECHNOLOGY
BENEFITS MODEL TOOL

3.1.1 RECOMtMIENDED CONFIGURATION

The recommended configuration for running the Macintosh version of the Technology Benefits Model
tool is:

"* A Macintosh capable of running Microsoft Excel, version 4.0

"* 4 megabytes of random access memory (RAM)

"* Macintosh system software, version 6.0.2 or later (tested on version 7.0.1)

"* Finder, version 6.1 or later

"* Microsoft Excel, version 4.0

"• Enough space on the hard disk for the Technology Benefits Model files (616 kilobytes)

"* A monitor large enough to display the Technology Benefits Model logo screen (at least 13 inches)

3.1.2 INSTALI.ING Till, SOFTWARE ON A HARD DISK

To copy the contents of the diskette to your hard disk, perform the following steps:

* Place the diskette containing the Technology Benefits Model tool in the disk drive.
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" Open the diskette by double-clicking on the diskette icon.

" Copy the TKBEN folder by clicking on the folder icon and dragging it to the hard drive icon.
Release the mouse button to start the copy procedure. The contents of the folder are placed
in a folder named TKBEN.

3.1.3 RUNNING THE TECHNOLOGY BENEFITS MODEL TOOL

3.1.3.1 Invoking the Technology Benefits Model Tool From a Diskette

To invoke t:.- Technology Benefits Model tool from a diskette, perform the following steps:

"* Place the diskette containing the Technlogy Benefits Model tool in the disk drive.

"* Open the diskette by double-clicking on the diskette icon. A window displaying the diskette
contents appears.

"* Open the TKBEN folder by double-clicking on the folder icon. A window displaying the folder
contents appears.

" Start the TKBEN application by double-clicking on the file TKBENBgn.xlm. The Technology
Benefits Model tool Start window appears.

3.1.3.2 Invoking the Technology Benefits Model Tool From a Hard Disk

To invoke the Technology Benefits Model tool from a hard disk, perform the following steps:

"* Open the hard drive by double-clicking on the hard drive icon. A window displaying the hard
drive contents appears.

"* Open the TKBEN folder by double-clicking on the folder icon. A window displaying the folder
contents appears.

"* Start the TKBEN application by double-clicking on the file TKBENBgn.xlm. The Technology
Benefits Model tool Start window appears.

Operation of the tool is described in Section 4.

3.2 INSTRUCTIONS FOR THE PC VERSION OF THE TECHNOLOGY BENEFITS
MODEL TOOL

3.2.1 RECOMMENDED CONFIGURATION

The recommended configuration for running the PC version of the Technology Benefits Model tool is:

* An IBM-compatible PC capable of running Microsoft Excel, version 4.0

* 4 megabytes of RAM
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3. Invoking the Tool

"* MS-DOS, version 3.3 or later (tested on version 5.00)

"* Microsoft Windows, version 3.0 or later (tested on version 3.1)

"* Microsoft Excel, version 4.0

"* Enough space on the hard disk for the Technology Benefits Model files (607 kilobytes)

"* A monitor large enough to display the Technology Benefits Model logo screen (at least 13 inches)

3.2.2 INSTALLING THE SOFrWARE ON A HARD DISK

To copy the contents of the diskette to your hard disk, perform the following steps:

" Place the diskette containing the Technology Benefits Model tool in the disk drive.

" From the File Manager, open the diskette by double-clicking on the diskette icon for the drive
in which you inserted the diskette.

" Copy the TKBEN folder by selecting the folder icon and dragging it to the hard drive icon.
Release the mouse button to start the copy procedure. The contents of the folder are placed
in a folder named TKBEN.

From the Program Manager Menu, select the program group in which to place TKBEN and
then select the File and New options. A property sheet appears.

" Verify that you have selected the program item and then click the [OK] button. The Program
Item Properties dialog box appears.

" In the description field, type TKBEN, then press the <TAB > key or move the mouse to the
command line field.

" In the command line field, type TKBENBgn.xlm and press < RETURN > or click the [OK]
button.

" In the working directory field, type C:\TKBEN.

" If you would like to replace the icon, select the [Change Icon] button before you click the [OK]
button or press < RETURN >. Then enter the full path name containing the icon file. If you
do not want to change your icon and accept the default icon, click the [OK] button.

Installation of the Technology Benefits Model tool on your hard disk is now complete.

3.2.3 RUNNING THE TECHNOLOGY BENEFITS MODEL TOOL

3.2.3.1 Invoking the Technology Benefits Model Tool From a Diskette

To invoke the Technology Benefits Model tool from a diskette, perform the following steps:
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"* Place the diskette containing the Technology benefits Model tool in the disk drive.

"* From the File Manager, select the drive in which you inserted the diskette. A window
displaying the diskette contents appears.

"• Open the TKBEN folder by double-clicking on the folder icon. A window displaying the folder
contents appears.

"* Start the TKBEN application by double-clicking on the file TKBENBgn.xlm. The Technology
Benefits Model tool Start window appears.

3.2.3.2 Invoking the Technology Benefits Model Tool From a Hard Disk

To invoke the Technology Benefits Model tool from a hard disk, perform the following steps:

"* From the File Manager, select the hard drive icon. A window displaying the hard drive
contents appears.

"* Open the TKBEN folder by double-clicking on the folder icon. A window displaying the folder
contents appears.

"* Start the TKBEN application by double-clicking on the file TKBENBgn.xlm. The Technology
Benefits Model tool Start window appears.

Operation of the tool is described in Section 4.

3.3 LIST OF FILES INCLUDED IN THE MACINTOSH AND PC VERSIONS OF THE
TECHNOLOGY BENEFITS MODEL TOOL

COVER.XLS

EXTENT.XLS

GRFDATXLS

IMPACTXLS

TKBEN.XLW

TKBENBGN.XLM

TKBENDBS.XLM

TKBENLOG.XLS

TKBENPRM.XLS
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4. OPERATING THE TECHNOLOGY BENEFITS
MODEL

4.1 USER INTERFACE CONVENTIONS

The Technology Benefits Model tool uses standard Microsoft Excel interface conventions whenever
possible. It provides custom menus to protect you from inadvertently modifying the application. It
also provides a user-friendly interface to those not well versed in using Microsoft Excel.

This section provides a brief description of the user interface conventions that the model uses. It also
provides examples of using the model, including creating graphs of data that you provide and that
the model calculates. For more detailed information about standard Microsoft Excel interface
conventions, please refer to the Microsoft Excel User's Guide (Microsoft 1991).

Figure 4-1 provides a menu hierarchy of the available functionality for the Technology Benefits Model
tool.

4.1.1 SELECTING FROM MENUS

Make a menu selection by holding down the mouse button and dragging the mouse over the menu
selections until you highlight your desired choice. Release the mouse button on the selected option
to execute your choice.

4.1.2 SELECTING FROM A WORKSHEET

Make a selection from a worksheet cell by moving the mouse to the desired cell and clicking the mouse
button to highlight that cell.

4.1.3 ACTA;XTING A WINDOW

Activate a window by clicking the mouse anywhere in the window. The title bar of a window contains
stripes when that window is active.

4.1.4 MENU BARS AND ACTIVE WINDOWS

The menu bar displayed corresponds to the appropriate type of menu bar for the active window. The
striped title bar indicates the active window.

4.1.5 CLOSING THE ACTIVE WINDOW

Close the active window by clicking the mouse button on the Close box in the upper left corner of the
window.
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Figure 4-1. Technology Benefits Model Menu Hierarchy

4.1.6 SIZING THE ACTIVE WINDOW

Use standard mouse techniques to size and move windows. To change the size of a window, select a
corner edge and drag the mouse to the desired location. To move a window, select a noncorner portion
of a window and drag the mouse to the desired location.

4.1.7 SCROLLING THE A¢-77IVE WINDOW

The tool provides both iporizontal and vertical scroll bars to scroll windows.

4.2 THE START WINDOW

The Start window is the window that appears when you activate the system (see Figure 4-2). It provides
access to all system functions.

The Start window consists of two parts: a static text area and a custom Microsoft Excel menu bar.
The static text area displays the Consortium logo and the tool name. The custom menu bar contains
the Startup menu. 'Me icon "Startup" in the upper left corner is a menu icon. Pointing the mouse at
this icon and holding down the mouse button (the left on a PC) causes the menu option described
in Section 4.2.1 to be displayed. The menu is described below:

4.2.1 THEF STARTUP MENIJ

The Startup menu provides the following options:
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4 Startup
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supporting documentation. This n-mterial is baed in pat upon work sponsored by the Advanced Reseach Projects Agency under
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THIS MATERIAL FOR ANY PURFOSE OR ABEOJT ANY OTHER MALTTER. AND THI MATERIAL I PROVIDED
WITHOlJf EXPRESS OR IMPLIED WARRANTY OF ANY KIND.

Figure 4-2. Start Window and Menu Bar

Begin. To access the remaining model functions, select Begin from the Startup menu. The Main
window then appears. Macintosh users should expect several minutes of delay before the main
window is displayed.

End. To exit the system before accessing any of the model functions, select End from the
Startup menu. End exits both this application and Microsoft Excel.

4.3 THE MAIN WINDOW

The Main window is the window that appears when you select Begin from the Startup menu (see
Figures 4-3, 4-4, 4-5, and 4-6). It provides access to the data manipulation functions.

The Main window consists of two parts: a worksheet and a custom Microsoft Excel menu bar. The
worksheet displays the outputs computed by the model. The custom menu bar contains the menus
from which you choose data manipulation operations. The worksheet is described in Section 4.3.1.
The menus are described in Section 4.3.2.

4.3.1 THE MAIN WINDOW WORKSHEET DESCRIPTION

These outputs are divided into seven categories: Unit Labor Rate vs Time, Unit Labor Cost vs Time,
Product Development Cost vs Time, Product Development Cost Savings vs Time, Market Cost vs
Time, Market Cost Savings vs Time, and Intermediate Results. The categories are described below.

4.3.1.1 Unit Labor Rate vs Time

The Unit Labor Rate vs Time portion of the worksheet is arranged into four rows of data. The first
row displays the year labels. The second row displays the computed value for the labor rate without
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Unit Labor Cost (K$/KSLOC) vs Time 1993 1994 1995......... ... ...... . ........... ..... ... ....... .
7 ithout appication oftechnolo .. . ...............10000 100.88 101.77

With application of technology, with user-entered extent
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Figure 4-3. Main Window and Menu Bar (part 1)

the use of any technology. The third row displays the computed value for the labor rate using the
specified technologies and the user-specified extent of use. The fourth row displays the computed val-
ue for the labor rate using the specified technologies and 100% extent of use. Computed labor costs
are expressed in LM/KSLOC.

4.3.1.2 Unit Labor Cost vs Time

The Unit Labor Cost vs Time portion of the worksheet is arranged into four rows of data. The first
row displays the year labels. The second row displays the computed value for the labor cost without
the use of any technology. The third row displays the computed value for the labor cost using the speci-
fied technologies and the user-specified extent of use. The fourth row displays the computed value
for the labor cost using the specified technologies and 100% extent of use. Computed labor costs are
expressed in LM/KSLOC.

4.3.1.3 Product Development Cost vs Time

The Product Development Cost vs Time portion of the worksheet is arranged into four rows of data.
The first row displays the year labels. The second row displays the computed value for the product
development cost without the use of any technology. The third row displays the computed value for
the product development cost using the specified technologies and the user-specified extent of use.
The fourth row displays the computed value for the product development cost using the specified
technologies and 100% extent of use. Computed development costs are expressed in KS.
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Figure 4-4. Main Window and Mcnu Bar (part 2)

4.3.1.4 Product Development Cost Savings vs; Time

The Product Development Cost Savings vs Time portion of the worksheet is arranged into thi-ce rows
of data. The first rowv displays the year labels. The second row displays the computed value for the
product development cost savings using the specified technologies and the user-specified extent of
use. The third row displays the computed value for the product development cost savings using the
specified technologies and 100% extent of use. Computed development costs are expressed in K$.

4.3.1.5 Market Cost vs Time

The Market Cost vs Time portion of the worksheet is arranged into four rows of data. The first rOW
displays the year labels. The second row displays the computed value for the market cost wvithout the
use of any technology. The third row displays the computed value for the market cost using thle speci-
fied technologies and the user-specified extent of use. The fourth rowv displays the computed value
for the market cost using the specified technologies and 100% extent of use. Computed costs to
address a market are expressed in K$.

4.3.1.6 Market Cost Savings vs Time

The Market Cost Savings vs Time portion of the worksheet is arranged into three rowvs of data. The

first row displays the year labels. The second row displays the computed value for the market cost
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4. Operating the Technology Benefits Model

savings using the specified technologies and the user-specified extent of use. The third row displays
the computed value for the market cost savings using the specified technologies and 100% extent of
use. Computed savings in the costs to address a market are expressed in K$.

4.3.1.7 Intermediate Results

The Intermediate Results portion of the worksheet displays data that is used to compute the major
outputs of the system. The first row displays the year labels. Each row labeled "TechnologyXRETy"
displays the computed values for the contribution of TechnologyX to RETy. Each row labeled "Tech-
nologyXRTTy" displays the computed values for the contribution of TechnologyX to RTTy. This dis-
play is useful for determining which technologies are included in the calculations of the model outputs.
Technologies that are either disabled or are not in use in a given year will display a value of zero for
the RET and RTT contributions. The zero for RET or RTT results fro.! one of three conditions: the
technology is disabled, the input for that technology for that year is zero, or the extent of use for that
technology for that year is zero. For further explanations of RET and RITE refer to the formulas
described in Appendix A.

4.3.2 THE MAIN WINDOW MENU DESCRIPTION

The custom menu bar contains the File, Activities, Technologies, Parameters, Graphs, and Window
menus. The menus are described below:

4.3.2.1 The File Menu

The File menu provides the following options:

" Print All. To print all of the worksheets, select Print All from the File menu. The standard
Microsoft Excel Print Preview window then appears for each worksheet to be printed.

"* Print Model Parameters. To print the model parameter values, select Print Model Parameters
from the File menu. The standard Microsoft Excel Print Preview window then appears.

"* Print Coverage. To print the coverage values, select Print Coverage from the File menu. The
standard Microsoft Excel Print Preview window then appears.

"• Print Extent. To print the extent values, select Print Extent from the File menu. The standard
Microsoft Excel Print Preview window then appears.

"* Print Inpact. To print the impact values, select Print Impact from the File menu. The standard
Microsoft Excel Print Preview window then appears.

"* Print Graph Data. To print the graph data values, select Print Graph Data from the File menu.
The standard Microsoft Excel Print Preview window then appears.

"• Save. To save the current state of the system, select Save from the File menu.

" Close. To exit the system, select Close from the File menu. As a result, a dialog box is presented.
Click the mouse on the [OK] button if you wish to save the data that you have just entered.
Otherwise, click the mouse on the [Cancel] button to revert to the most recently saved data.
Close exits both this application and Microsoft Excel.
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NoTE: Attempting to print when there is no printer connected may result in a macro error. Should
this happen, click the mouse on the [Haiti button to return to normal operation.

4.3.2.2 The Activities Menu

The Activities menu contains the Set Activity Names entry.

This operation provides the edit capabilities for the model activities. The operation is described in
detail below.

Set Activity Names. Choose the Set Activity Names option from the Activities menu to modify
the names of the model activities. Set Activity Names presents you with a dialog box
(Figure 4-7) to modify the names of the model activities.

.Activity Names Input Dialog BoH

Activity

Preliminary Design
Detailed Design
Coding and CSU Testing
CSC Integration and Testing

New Name Cancel

Figure 4-7. Activity Narnes Input Dialog Box

- Select the name of the activity to be renamed from the Activity list box.

- Type the new name in the edit box.

- Click [Accept] to accept the new name.

- Continue renaming activities in this fashion (accepting each new name in turn) until
all of the desired names appear in the Activity list box.

- Click [Cancel] to exit the dialog box. It takes approximately 30 seconds for the tool
to recalculate.

Example: To set the name of Activity7 to Project Management:

1. Select Set Activity Names from the Activities menu to display the Activity Names

Input Dialog Box.

2. Select Activity7 in the Activity list box.
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3. Type the name Project Management in the New Name text edit box.

4. Click the [Accept] button to accept the name modification. The dialog box will be

refreshed automatically with the new name appearing in the Activity list box.

5. Click the [Cancel] button to terminate the Set Activity Names operation.

4.3.2.3 The Technologies Menu

The Technologies menu contains the entries

"* Set Technology Names

"* Set Technology otart/End

"* Set Technology Status

These operations provide the edit capabilities for the model technologies. The operations are
described in detail below.

* Set Technology Names.Choose the Set Technology Names option from the Technologies menu
to modify the names of the model technologies. Set Technology Names presents you with a
dialog box (Figure 4-8) to modify the names of the model technologies.

Technology Names Input Dialog BoH

Technology

Design Tool
Technology3 ij3
Technology4 ij 4
Technology5

New Name

Figure 4-8. Technology Names Input Dialog Box

- Select the name of the capability to be renamed from the Technology list box.

- Type the new name in the edit box.

- Click [Accept] to accept the new name.

- Continue renaming technologies in this fashion (accepting each new name in turn)
until all of the desired names appear in the Technology list box.

- Click [Cancel] to exit the dialog box.
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Note that the technology names that do not apply can be disabled (see Set Technology Status
below). Also, note that a new technology inherits the status and the start and end years of the
technology it renames.

Example: To set the name of Technology3 to Ada Quality and Style:

1. Select Set Technology Names from the Technologies menu to display the
TechnologyNames Input Dialog Box.

2. Select Technology3 in the Technology list box.

3. Type the name Ada Quality and Style in the New Name text edit box.

4. Click the [Accept] button to accept the name modification. The dialog box will be
refreshed automatically with the new name appearing in the Technology list box.

5. Click the [Cancel] button to terminate the Set Technology Names operation.

Set Technology Start/End. Choose the Set Technology Start/End option from the Technologies
menu to modify the start and end year values of the model technologies. Set Technology Start/
End presents you with a dialog box (Figure 4-9) to modify the start and end years of the model
technologies. The default start year for each technology is the first year defined for the model
(see start year in Figure 4-9). The default end year for each technology is equal to the start
year plus 14.

StartEnd Dialog Box ,,,

Technology

Design Tool
Technology3
Technology4
Technology5 5

Start Year End Year
2003 Cancel

11994 2004
1995 2005 ccept

j1996 200611997 AI Wf

Figure 4-9. StartEnd Dialog Box

- Select the name of the technology to be modified from the Technology list box. The
current start and end years are highlighted in the corresponding list boxes.

- Select the new start year from the Start Year list box.
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- Select the new end year from the End Year list box.

- Click [Accept] to accept the new start and end years.

- Continue modifying the start and end years for each technology in this fashion (accepting
each range in turn) until all of the technologies have the desired start and end years.

- Click [Cancel] to exit the dialog box.

Example: To set the start and end years for the Design Tool technology to 1995 and 2007,
respectively:

1. Select Set Technology Start/End from the Technologies menu to display the StartEnd
Dialog Box.

2. Select Design Tool in the Technology list box. The dialog box will be refreshed
automatically to display the current start and end years for Design Tool.

3. Select 1995 in the Start Year list box.

4. Select 2007 in the End Year list box.

5. Click the [Accept] button to accept the start and end year modifications. The dialog
box will be refreshed automatically with the new start and end years highlighted in the
respective list boxes.

6. Click the [Cancel] button to terminate the Set Technology Start/End operation.

Set Technology Status. Choose the Set Technology Status option from the Technologies menu
to modify the status of the model technologies. Set Technology Status presents you with a dia-
log box (Figure 4-10) to modify the status of the model technologies. Enabled status means
that the technology is included in the calculations of the worksheet formulas. A status of dis-
abled means that the technology is ignored in the calculations of the worksheet formulas. The
default status for each technology is enabled.

- Select the name of the technology to be modified from the Technology list box. The
current Status button is highlighted in the Technology Status option button group.

- Select the new status from the Technology Status option button group.

- Click [Accept] to accept the new status.

- Continue modifying the Status for each technology in this fashion (accepting each
status in turn) until all of the technologies have the desired status.

- Click [Cancel] to exit the dialog box.

Example: To facilitate the exploration of the effect of individual technologies, you can enable
or disable a technology, thus including or removing it from consideration. To set the status
for the Design Tool technology to disabled (thus removing it from consideration):
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Technology Selection Dialog BoH -. _

Technology
ReqI rmn ITI

Design Tool
Technology3
Technology4
Technology•j

Technology Status-
0 Disabled Cancel

® Enabled

Figure 4-10. Technology Selection Dialog Box

1. Select Set Technology Status from the Technologies menu to display the Technology
Selection Dialog Box.

2. Select Design Tool in the Technology list box. The dialog box will be refreshed
automatically to display the current status for Design Tool.

3. Select the Disabled button in the Technology Status option button group.

4. Click the [Accept] button to accept the status modification. The dialog box will be
refreshed automatically with the new status selected in the option button group.

5. Click the [Cancel] button to terminate the Set Technology Status operation.

4.3.2.4 The Parameters Menu

The Parameters menu contains the entries

"* Set Model Parameters

"* Set Coverage Values

"* Set Extent Values

"* Set Impact Values

These operations provide the edit capabilities for the model parameters. The operations are described
in detail below.

* Set Model Parameters. Choose the Set Model Parameters option from the Parameters menu
to modify the values of the global parameters used in the model. Set Model Parameters
presents you with a dialog box (Figure 4-11) to modify the global model parameters.
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Al I I Unit Labor Rate (LM/KSLOC) vs Time

"I]___________ Grffat.xIs _" _ _ _ _ _ _

_ _ _ _ Model Parameter Input Dialog Box _

"L = Baseline unit labor rate (LM/KSLOC)"

"C = Baseline unit labor cost (K$/LM)" 10.00

"pw = % annual wage increase" 4.00

"ac = % annual labor rate decrease not due to technology" 33.00

"S = Size of product in KSLOC " 1000.00

"M = Baseline market size (KSLOC) " 10000.00

"pm = Market size annual % growth rate " 4.00 Cancel

"First Year" 1993

Figure 4-11. Model Parameter Input Dialog Box

- Use the tab key or the mouse to navigate among the edit boxes in the dialog box.

- Click [Accept] to accept the new values, or click [Cancel] to ignore the new values.

Table 2-1 provides descriptions of each of these parameters. You should consider your
parameter selection after deciding what information you want from running the tool. Table 2-2
shows the applications of the various graphs that the tool can provide.

Table 4-1 shows the input parameter constraints.

Table 4-1. Input Parameter Constraints

Input Parameter Input Parameter
Symbol Input Parameter Description Constraint

L Baseline (first year) unit labor rate (LM/KSLOC) > 0

C Baseline (first year) tunit labor cost (K$/LM) C > 0

pw Percent annual wage increase Unconstrained

ac Percent annual labor rate decrease not due to technology whose Unconstrained
impact is being modeled

S Size of product in KSLOC S > 0

M Baseline market size (KSLOC) M > 0

pm Market size annual percent growth rate Unconstrained

Example: To set the size of product (S) = 1,500 and baseline unit labor cost (C) = 12:

1. Select Set Model Parameters from the Parameters menu to display the Model
Parameter Input Dialog Box. The dialog box displays the current values of the model
parameters.
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2. Type the value 12 in the Baseline unit labor cost text edit box.

3. Type the value 1,500 in the Size of product text edit box.

4. Click the [Accept] button to accept the parameter modifications.

Set Coverage Values. Choose the Set Coverage Values option from the Parameters menu to
modify the coverage values of the model activities. Set Coverage Values presents you with a
dialog box (Figure 4-12) to modify the coverage of the model activities. The coverage values
are constrained to be greater than or equal to 0, and the sum of the values is equal to 100. To
specify the coverage value for a given activity:

Couerage Input Dialog BoH

Rctiuity

Preliminary Design
Detailed Design
Coding and CSU Testing
CSC Integration and Testing

Coverage : wwr• Sok Cancel- ~100.00 1____

Figure 4-12. Coverage Input Dialog Box

- Select the name of the activity to be modified from the Activity list box. The current
coverage value is displayed in the Coverage text box.

- Type the new coverage value in the Coverage text box.

- Click [Accept] to accept the new value.

- Continue modifying the coverage values for each activity in this fashion (accepting
each coverage value in turn) until all of the activities have the desired values.

- Click [Cancel] to exit the dialog box.

- Upon exit, the application will verify that the sum of all coverage values is 100.
Violation of this constraint will cause a message to appear, and the Coverage Input
dialog box will reappear so that the values may be adjusted.

Table 4-2 shows the coverage parameter constraints.
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Table 4-2. Coverage Parameter Constraints

Input Parameter Input Parameter
Symbol Input Parameter Description Constraint

Cp Coverage, percent of development process to which the indi- 0 < = Cp < = 100
cated activity applies. This parameter is approximated as being
constant in time for each activity "p." That is, it does not in-
clude the effect of changing the marginal cost impact effect.

Example: To set the distribution of development effort among activities to Requirements
Analysis = 7.4, Preliminary Design = 16.7, Detailed Design = 22.2 Coding and CSU Testing
= 22.2, CSC Integration and Testing = 16, and CSCI Testing = 15.5:

1. Select Set Coverage Values from the Parameters menu to display the Coverage Input
Dialog Box.

2. Select Requirements Analysis in the Activity list box. The dialog box will be refreshed
automatically to display the current coverage for the selected activity.

3. Type the value 7.4 in the Coverage text edit box.

4. Click the [Accept] button to accept the coverage modification. The dialog box will be
refreshed automatically with the new coverage displayed in the text edit box.

5. Select Preliminary Design in the Activity list box. The dialog box will be refreshed
automatically to display the current coverage for the selected activity.

6. Type the value 16.7 in the Coverage text edit box.

7. Click the [Accept] button to accept the coverage modification. The dialog box will be
refreshed automatically with the new coverage displayed in the text edit box.

8. Select Detailed Design in the Activity list box. The dialog box will be refreshed

automatically to display the current coverage for the selected activity.

9. Type the value 22.2 in the Coverage text edit box.

10. Click the [Accept] button to accept the coverage modification. The dialog box will be
refreshed automatically with the new coverage displayed in the text edit box.

11. Select Coding and CSU Testing in the Activity list box. The dialog box will be refreshed
automatically to display the current coverage for the selected activity.

12. Type the value 22.2 in the Coverage text edit box.

13. Click the [Accept] button to accept the coverage modification. The dialog box will be
refreshed automatically with the new coverage displayed in the text edit box.

14. Select CSC Integration and Testing in the Activity list box. The dialog box will be
refreshed automatically to display the current coverage for the selected activity.
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15. Type the value 16 in the Coverage text edit box.

16. Click the [Accept] button to accept the coverage modification. The dialog box will be
refreshed automatically with the new coverage displayed in the text edit box.

17. Select CSCI Testing in the Activity list box. The dialog box will be refreshed
automatically to display the current coverage for the selected activity.

18. Type the value 15.5 in the Coverage text edit box.

19. Click the [Accept] button to accept the coverage modification. The dialog box will be
refreshed automatically with the new coverage displayed in the text edit box.

20. Select each of the remaining activities in turn, set the coverage value to 0, and click
the [Accept] button. Note that the Coverage Sum box equals 100.00.

21. Click the [Cancel] button to terminate the Set Coverage Values operation.

Set Extent Values. Choose the Set Extent Values option from the Parameters menu to modify
the extent values of the model technologies. Set Extent Values presents you with a dialog box
(Figure 4-13) to modify the extent of the model technologies. The default extent for each tech-
nology is zero. The extent values are constrained to be greater than or equal to 0 and less than
or equal to 100. To compute the extent values for the years between the start year and end year,
the model linearly interpolates between the start year extent and the end year extent. To specify
the start year and end year extent values for a given technology:

--__ - EHtent Input Dialog BOH

Technology

Design Tool

Technology3

Technology45

Start Year End Year

11993 120071
Start Year EHtent End Year Extent Cancel

F IZ00 01t
Figure 4-13. Extent Input Dialog Box

- Select the name of the technology to be modified from the Technology list box. The
current first and last year extent values are displayed in the appropriate text boxes.

- Type the new first and last year extent values in the appropriate text boxes.
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- Click [Accept] to accept the new values.

- Continue modifying the extent values for each technology in this fashion (accepting
each pair of first and last year extent values in turn) until all of the technologies have
the desired values.

- Click [Cancel] to exit the dialog box.

Table 4-3 shows the extent parameter constraints.

Thble 4-3. Extent Parameter Constraints

Input Parameter Input Parameter
Symbol Input Parameter Description Constraint

Eky Extent of use, percent of the user organization applying tech- 0< = Eky < = 100
nology "k" in year "y." For 100% extent of use, Eky = 100.

Example: To set the extent of use of the Requirements Tool technology at a constant 50%:

1. Select Set Extent Values from the Parameters menu to display the Extent Input Dialog
Box.

2. Select Requirements Tool in the Technology list box. The dialog box will be refreshed
automatically to display the current start year and end year extents of use for the
selected technology.

3. Type the value 50 in the Start Year Extent text edit box.

4. Type the value 50 in the End Year Extent text edit box.

5. Click the [Accept] button to accept the extent modifications. The dialog box will be
refreshed automatically with the new start year and end year extents displayed in the
respective text edit boxes.

6. Click the [Cancel] button to terminate the Set Extent Values operation.

Set Impact Values. Choose the Set Impact Values option from the Parameters menu to modify
the impact of the technologies on the activities. Set Impact Values presents you with a dialog
box (Figure 4-14) to modify the impact of the model technologies on the model activities. The
default impact for each technology-activity combination is zero. The impact values are con-
strained to be greater than or equal to -100 and less than or equal to 100. To compute the im-
pact values for the years between the start year and end year, the model linearly interpolates
between the start year impact and the end year impact. To specify the start year and end year
impact values for a given technology-activity combination:

- Select the name of the technology to be modified from the Technology list box.

- Select the name of the activity to be modified from the Activity list box. The current
start and end year impact values are displayed in the appropriate text boxes.

4-17



4. Operating the Technology Benefits Model

Impact Input Dialog Box

Technology

Design Tool
TechnologV3
Technology4 .-
Technology5 P1

octiuity

Preliminary Design
Detailed Design
Coding and CSU Testing
CSC Integration and Testing

Start Year End Year

11993 11107
Start Year Impact End Year Impact Cancel

•,iI~l [-5.DO0

Figure 4-14. Impact Input Dialog Box

- Type the new start and end year impact values in the appropriate text boxes.

- Click [Accept] to accept the new values.

- Continue modifying the impact values for each technology and activity combination
in this fashion (accepting each set of start and end year impact values in turn) until
all of the technology and activity combinations have the desired values.

- Click [Cancel] to exit the dialog box.

Table 4-4 shows the impact parameter constraints.

Table 4-4. Impact Parameter Constraints

Input Parameter Input Parameter
Symbol Input Parameter Description Constraint

Ikpy Impact of use, percent unit net cost reduction (net savings) due -100 < = Ikpy
to applying a technology "k" on activity "p" in year "y." A posi- < = 100
tive value of Ikpy, between 0 and 100, is uscd to indicate a net
savings. A negative value of Ikpy, between 0 and 100, is used to
indicate a net cost.

Example: To set the impact of the Requirements Tool technology on the Requirements Analysis
activity to be -10% in 1993 and -5% in 2007:
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1. Select Set Impact Values from the Parameters menu to display the Impact Input
Dialog Box.

2. Select Requirements Tool in the Technology list box. The dialog box will be refreshed
automatically to display the current start year and end year impact for the selected
technology on the selected activity.

3. Select Requirements Analysis in the Activity list box. The dialop box will be refreshed
automatically to display the current start year and end year impacts for the selected
technology on the selected activity.

4. Type the value -10 in the Start Year Impact text edit box.

5. Type the value -5 in the End Year Impact text edit box.

6. Click the [Accept] button to accept the impact modifications. The dialog box will be
refreshed automatically with the new start year and end year impacts displayed in the
respective text edit boxes.

7. Click the [Cancel] button to terminate the Set Impact Values operation.

4.3.2.5 The Graphs Menu

The Graphs menu generates built-in graphs for model calculations. The Graphs menu contains the
entries Unit Labor Rate vs Time, Unit Labor Cost vs Time, Product Development Cost vs Time, Mar-
ket Cost vs Time, and Market Cost Savings vs Time. Selection of one of these choices from the Graphs
menu results in the display of the appropriate chart. You can display any or all of the graphs simulta-
neously. If you modify any of the parameters while one or more graphs are displayed, the values on
the graphs will be recomputed.

Points are plotted for each year from the first year of the model up to and including the last year of
an enabled technology. Due to a Microsoft Excel constraint, the number of points plotted must be
greater than the number of curves plus one; therefore, you will see at least 4 years when plotting two
curves.

To exit a displayed chart, click on the box in the upper left corner of the chart. As a result, a dialog
box will be presented. Click [Yes] if you wish to save the chart, click [No] if you wish to discard the
chart, or click [Cancel] to abort the exit attempt and leave the chart displayed on the screen.

To produce a graph from the worksheet data, select the desired graph from the Graphs menu. There
are five built-in graphs that you can produce:

"* Unit Labor Rate vs Time

"° Unit Labor Cost vs Time

"* Product Development Cost vs Time

"* Market Cost vs Time

"* Market Cost Savings vs Time
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4.3.2.6 The Window Menu

The Window menu contains the Arrange All entry.

This operation provides the window manipulation capabilities for the model. The ope-ration is
described in detail below.

Arrange All. Choose the Arrange All option from the Window menu to simu!taneously display
all open windows. This is useful for viewing multiple graphs at the sarr'e time. A sample display
resulting from invocation of the Arrange All menu selection is shown in Figure 4-15.

SFile Rctiuities Technologies Parameters Graphs Window
Al Unit Labor Rate (LA/SLOC) vs Time ______________________ ________

Chartl 6 rf~al.iss

Unit Labor Rate vs lime . ao ae(.1MOv i 93 19

OWNiat of bCWold91 uW tenoterw AM
10.00 of Wm 998 9.64:

Vilhp iwf WMlogyvith tCOD%txwtofw.
9.00 (b4 4 (towwjl~u 9.95: 9.58

8.00 Witolet application ______ ____________

7.00 Witah~~ Wa mtlkCost (KI/KSLOC)vs Tim 1993: 1994:

S60 With apphlfacaoof :2Vi~ew ipliuw o 100.001 100.88:
0 tthYM~Vt 4picaftim of WaW ith usr-tateredextf

an&ea~reofn W f 99.76: 100.251
N ~of wse wtif o~ ION lmOXti11of We

.~401 (theual sitsatwm 99,52: 99.61:
* --With application of

3.00 tethioolog1, with
100%uentotf use 11PrdactDevelopnt Cost OC$) s Tim. 1993: 19941

2.00 (the ideal situation)
abtmoftd b 100,00000 100,880.09; 101.

1.00 Vilh appcatim of teco~olo, vit use-wtert extoni

00 11:o aIn 99,759.00i 100,245.26: l01t

0.00asiu n 9958.0 9962.1 101
1990 1995 2000 2005 201014ftaliuu).2~0jiAl-

Year 5__________
Copyright 1993, Software Productivity tonsorti un , I o. All rights reserved. 7 a

Figure 4-15. Arrange All Display

4.3.3 THE SAMPLE DATA AND GRAPHS

The sample data used to create the figures in this manual is representative of an organization that
has an activity profile consisting of six development activities. The activities and their associated cov-
erage values are shown in Table 4-5. The organization can use this model to study the effect of two
technologies, a Requirements Tool and a Design Tool, either individually or in combination. The extent
of use of each of the technologies is shown in Table 4-6, which shows that each technology has a con-
stant extent of use. The model allows for linear interpolation between the start and the end year extents,
thereby allowing the extent of use to increase or decrease over time. The net impact of each technology
on each activity is shown in Table 4-7. As shown in Table 4-7, the impact of a technology on an activity
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can change over time, e.g., Design Tool affects the Preliminary Design activity negatively (-5) in 1993,
but its impact is positive (+ 10) in 2007. This is a situation in which there is a learning curve involved
in the adoption of technology. As with extent of use, the model allows for linear interpolation between
start year impact and end year impact values. The start year, end year, and status for each technology
are shown in Table 4-8. As shown in Table 4-8, the Requirements Tool is in use from 1993 to 2007, while
the Design Tool is proposed for adoption starting in 1995 and will be in use until 2007. This is a case
of the phased adoption of technology. The graphs displayed in this manual were generated using the
parameter values shown in Table 4-9 unless otherwise specified.

Table 4-5. Coverage Values

Activity Name Coverage Value

Requirements Ana'ysis 7.4

Preliminary Design 16.7

Detailed Design 22.2

Coding and CSU Testing 22.2
CSC Integration and Testing 16

CSCI Testing 15.5

Activity7-12 0

'Tble 4-6. Extent Values*

Technology Name Start Year Extent End Year Extent

Requirements Tool 50 50

Design Tool 50 50

Technology3-9 0 0
* It is not necessary to reset the start and end year extents of use for disabled technologies.

Table 4-7. Impact Values*

Technology Name/Activity Name ]Requirements Tool Design Tool Technology3-9

Requirements Analysis Start =-10, End =-5 Start=--8, Start = 0, End =0
End = -3

Preliminary Design Start = 2, End = 10 Start = -5, Start = 0, End = 0
End = 10

Detailed Design Start = 2, End = 10 Start = -5, Start = 0, End = 0

End = 10

Coding and CSU Testing Start = 2, End = 5 Start = 0, End = 0 Start = 0, End = 0

CSC Integration and Testing Start = 0, End = 0 Start = 0, End = 0 Start = 0, End = 0

CSCI Testing Start=0, End=0 Start=0, End=0 Start=0, End=0

Activity7-12 Start=0, End=0 Start=0, End=0 Start=0, End=0

* It is not necessary to reset the start and end impacts for disabled technologies.
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Table 4-8. Technology Start/End and Status Values

Technology Name Start Year End Year Status

Requirements Tool 1993 2007 Enabled

Design Tool 1995 2007 Enabled

Technology3-9 1993 2007 Disabled

Thble 4-9. Input Parameter Values

Input Parameter Input Parameter
Symbol Input Parameter Description Value

L Baseline (first year) unit labor rate (LM/KSLOC) 10

C Baseline (first year) unit labor cost (K$/LM) 10
pw Percent annual wage increase 4

ac Percent annual labor rate decrease not due to technology whose 3
impact is being modeled

S Size of product in KSLOC 1,000
M Baseline market size (KSLOC) 10,000
pm Market size annual percent growth rate 4
Eky Extent of use, percent of user organization applying technology See Table 4-6

"k" in year "y." For 100% extent of use, Eky= 100.
Ikpy Impact of use, percent unit net cost reduction (net savings) due See Table 4-7

to applying a technology "k" on activity "p" in year "y." A posi-
tivc vue of Ikp, between 0 and 100, is used to indicate a net
savings. A negative value of Ikpy, between 0 and 100, is used to
indicate a net cost.

CP Coverage, percent of development process to which the indicated See Table 4-5
activity applies. This parameter is approximated as being constant
in time for each activity "p". That is, it does not include the ef-
fect of changing the marginal cost impact effect.

4.3.3.1 Unit Labor Rate vs Time Graph

The Unit Labor Rate vs Time graph plots labor months per KSLOC vs time. The three curves plotted
(Figures 4-16 and 4-17) represent the following situations:

"* Without application of technology

"* With application of technology, with user entered-extent of use

"* With application of technology, with 100% extent of use (the ideal situation)

Example: Figure 4-16 shows the estimated change in labor rate during the years 1993 to 2007.
For this example, only the Requirements Tool is being considered; therefor-, the Design Tool
is disabled so that you can measure the effect of a single technology. To determine the esti-
mated change in unit labor rate due to a single technology during the years 1993 to 2007:

1. Follow the instructions for Set Model Parameters to set Baseline unit labor rate and
Percent annual labor rate decrease not due to technology to appropriate values. For
our example:
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Figure 4-16. Unit Labor Rate vs Time Graph Window Showing Estimated Reduction in Labor Rate

- Baseline unit labor rate = 10

- Percent annual labor rate decrease not due to technology = 3

2. Follow the instructions for Set Technology Status to set the status of the technology
in question to enabled and to set the status of the other technologies to disabled. For
our example:

- Requirements Tool status =enabled

- Other technologies status = disabled
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Figure 4-17. Unit Labor Rate vs Time Graph Window Showing Proportional Reduction in Labor Rate

3. Follow the instructions for Set Technology Start/End to set the start and end years of
the technology in question to appropriate values. For our example:

- Requirements Tool start year = 1993

- Requirements Tool end year= 2007

4. Follow the instructions for Set Coverage Values to set the coverage for the activities
(see Table 4-5).

5. Follow the instructions for Set Extent Values to set the extent of use for the technology
in question (see Table 4-6).

4-24



4. Operating the Technology Benefits Model

6. Follow the instructions for Set Impact Values to set the impact for each activity upon
which the technology in question has an effect (see Table 4-7).

7. Select Unit Labor Rate vs Time from the Graphs menu and interpret output (shown
in Figure 4-16) as labeled.

Example: Figure 4-17 shows the proportional change in labor rate during the years 1993 to 2007.
For this example, only the Requirements Tool is being considered; therefore, the Design Tool
is disabled so that you can measure the effect of a single technology. To determine the propor-
tional change in unit labor rate due to a single technology over the years 1993 to 2007:

1. Follow the instructions for Set Model Parameters to set Baseline unit labor rate and
Percent annual labor rate decrease not due to technology to appiopriate values. For
our example:

- Baseline unit labor rate = 1

- Percent annual labor rate decrease not due to technology =3

2. Follow the instructions for Set Technology Status to set the status of the technology
in question to cnabled and to set the status of the other technologies to disabled. For
our example:

- Requirements Tool status = enabled

- Other technologies status = disabled

3. Follow the instructions for Set Technology Start/End to set the start and end years of
the technology in question to appropriate values. For our example:

- Requirements Tool start year = 1993

- Requirements Tool end year = 2007

4. Follow the instructions for Set Coverage Values to set the coverage for the activities
(see Table 4-5).

5. Follow the instructions for Set Extent Values to set the extent of use for the technology
in question (see Table 4-6).

6. Follow the instructions for Set Impact Values to set the impact for each activity upon
which the technology in question has an effect (see Table 4-7).

7. Select Unit Labor Rate vs Time from the Graphs menu and interpret output (shown
in Figure 4-17) as a proportion.

4.3.3.2 Unit Labor Cost vs Time Graph

The Unit Labor Cost vs Time graph plots K$ per KSLOC versus time. The three curves plotted
(Figure 4-18) represent the following situations:
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"* Without application of technology

"° With application of technology, with user-entered extent of use

"* With application of technology, with 100% extent of use (the ideal situation)
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Figure 4-18. Unit Labor Cost vs Time Graph Window

Example: Figure 4-18 shows the estimated change in labor cost during the years 1993 to 2007.
For this example, only the Requirements Tool is being considered; therefore, the Design Tool
is disabled so that you can measure the effect of a single technology. To determine the esti-
mated change in unit labor cost due to a single technology during the years 1993 to 2007:

1. Follow the instructions for Set Model Parameters to set Baseline unit labor rate to an
appropriate value, Percent annual labor rate decrease not due to technology to an appro-
priate value, Baseline unit labor cost, and Percent annual wage increase. For our example:
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- Baseline unit labor rate = 10

- Percent annual labor rate decrease not due to technology = 3

- Baseline unit labor cost = 10

- Percent annual wage increase = 4

2. Follow the instructions for Set Technology Status to set the status of the technology
in question to enabled and to set the status of the other technologies to disabled. For
our example:

- Requirements Tool status = enabled

- Other technologies status = disabled

3. Follow the instructions for Set Technology Start/End to set the start and end years of
the technology in question to appropriate values. For our example:

- Requirements Tool start year = 1993

- Requirements Tool end year = 2007

4. Follow the instructions for Set Coverage Values to set the coverage for the activities
(see Table 4-5).

5. Follow the instructions for Set Extent Values to set the extent of use for the technology
in question (see Table 4-6).

6. Follow the instructions for Set Impact Values to set the impact for each activity upon
which the technology in question has an effect (see Table 4-7).

7. Select Unit Labor Cost vs Time from the Graphs menu and interpret output (shown
in Figure 4-18) as labeled.

4.3.3.3 Product Development Cobt vs Time Graph

The Product Development Cost vs Time graph plots K$ versus time. The three curves plotted (Figures
4-19 and 4-20) represent the following situations:

" Without application of technology

"* With application of technology, with user-entered extent of use

"* With application of technology, with 100% extent of use (the ideal situation)

Example: Figure 4-19 shows the estimated change in product development cost during the
years 1993 to 2007. For this example, only the Requirements Tool is being considered, with the
Requirements Tool adoption to start in 1993. To determine the estimated change in product
development cost due to the adoption of the Requirements Tool technology during the years
1993 to 2007:
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Figure 4-19. Product Development Cost vs Time Graph Window Showing One Tool Considered

1. Follow the instructions for Set Model Parameters to set Baseline unit labor rate to an
appropriate value, Percent annual labor rate decrease not due to technology to an ap-
propriate value, Baseline unit labor cost, Percent annual wage increase, and Size of
product. For our example:

Baseline unit labor rate = 10

- Percent annual labor rate decrease not due to technology = 3

- Baseline unit labor cost= 10

- Percent annual wage increase= 4

- Size of product= 1,000

2. Follow the instructions for Set Technology Status to set the status of the technology
in question to enabled and to set the status of the other technologies to disabled. For
our example:

- Requirements Tool status = enabled

- Other technologies status = disabled

3. Follow the instructions for Set Technology Start/End to set the start and end years of the
technology in question (e.g., Requirements Tool) to appropriate values. For our example:
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Figure 4-20. Product Development Cost vs Time Graph Window Showing Two Tools Considered

- Requirements Tool start year = 1993

- Requirements Tool end year = 2007

4. Follow the instructions for Set Coverage Values to set the coverage for the activities
(see Table 4-5).

5. Follow the instructions for Set Extent Values to set the extent of use for the technologies
in nuestion (see Table 4-6).

6. Follow the instructions for Set Impact Values to set the impact for each activity upon
which the technology in question has an effect (see Table 4-7).

7. Select Product Development Cost vs Time from the Graphs menu and interpret output
(shown in Figure 4-19) as labeled.

Example: Figure 4-20 is an example of the phased introduction of two technologies. It shows
the estimated change in product development cost during the years 1993 to 2007. For this ex-
ample, both the Requirements Tool and the Design Tool are being considered, with the Re-
quirements Tool adoption to start in 1993 and the Design Tool adoption to start in 1995. To
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determine the estimated change in product development cost due to the phased adoption of
two technologies during the years 1993 to 2007:

1. Follow the instructions for Set Model Parameters to set Baseline unit labor rate to an
appropriate value, Percent annual labor rate decrease not due to technology to an ap-
propriate value, Baseline unit labor cost, Percent annual wage increase, and Size of
product. For our example:

- Baseline unit labor rate= 10

- Percent annual labor rate decrease not due to technology= 3

- Baseline unit labor cost= 10

- Percent annual wage increase=4

- Size of product = 1,000

2. Follow the instructions for Set Technology Status to set the status of the technologies
in question to enabled and to set the status of the other technologies to disabled. For
our example:

- Requirements Tool status =enabled

- Design Tool status =enabled

- Other technologies status =-disabled

3. Follow the instructions for Set Technology Start/End to set the start and end years of
the technologies in question (e.g., Requirements Tool and Design Tool) to appropriate
values. For our example:

- Requirements Tool start year = 1993

- Requirements Tool end year =2007

- Design Tool start year= 1995

- Design Tool end year= 2007

4. Follow the instructions for Set Coverage Values to set the coverage for the activities
(see Table 4-5).

5. Follow the instructions for Set Extent Values to set the extent of use for the technologies
in question (see Table 4-6).

6. Follow the instructions for Set Impact Values to set the impact for each activity upon
which the technologies in question have an effect (see Table 4-7).

7. Select Product Development Cost vs Time from the Graphs menu and interpret output
(shown in Figure 4-20) as labeled.
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4.3..4 Market Cost vs Time Graph

The Market Cost vs Time graph plots K$ versus time. The three curves plotted (Figure 4-21) represent
the following situations :

"* Without application of technology

"• With application of technology, with user-entered extent of use

"• With application of technology, with 100% extent of use (the ideal situation)
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Figure 4-21. Market Cost vs Time Graph Window

Example: Figure 4-21 shows the estimated change in cost of satisfying a market of a given size
during the years 1993 to 2007. For this example, both the Requirements Tool and the Design
Tool are being considered, with the Requirements Tool adoption to start in 1993 and the Design
Tool adoption to start in 1995. To determine the estimated change in market cost due to the
phased adoption of two technologies over the years 1993 to 2007:

1. Follow the instructions for Set Model Parameters to set Baseline unit labor rate to an
appropriate value, Percent annual labor rate decrease not due to technology to an ap-
propriate value, Baseline unit labor cost, Percent annual wage increase, Baseline
market size, and Market size annual percent growth rate. For our example:

4-31



4. Operating the Technology Benefits Model

- Baseline unit labor rate = 10

- Percent annual labor rate decrease not due to technology = 3

- Baseline unit labor cost = 10

- Percent annual wage increase = 4

- Baseline market size = 10,000

- Market size annual percent growth rate = 4

2. Follow the instructions for Set Technology Status to set the status of the technologies
in question to enabled and set the status of the other technologies to disabled. For our
example:

- Requirements Tool status = enabled

- Design Tool status = enabled

- Other technologies status = disabled

3. Follow the instructions for Set Technology Start/End to set the start and end years of
the technologies in question (e.g., Requirements Tool and Design Tool) to appropriate
values. For our example:

- Requirements Tool start year = 1993

- Requirements Tool end year = 2007

- Design Tool start year = 1995

- Design Tool end year = 2007

4. Follow the instructions for Set Coverage Values to set the coverage for the activities
(see Table 4-5).

5. Follow the instructions for Set Extent Values to set the extent of use for the technologies
in question (see Table 4-6).

6. Follow the instructions for Set Impact Values to set the impact for each activity upon
which the technologies in question have an effect (see Table 4-7).

7. Select Market Cost vs Time from the Graphs menu and interpret output (shown in
Figure 4-21) as labeled.

4.3.3.5 Market Cost Savings vs Time Graph

The Market Cost Savings vs Time graph plots K$ versus time. The two curves plotted (Figure 4-22)
represent the following situations :

"* Savings due to use of technology, with user-entered extent of use

"* Savings due to use of technology, with 100% extent of use (the ideal situation)
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Figure 4-22. Market Cost Savings vs Time Graph Window

Example: Figure 4-22 shows the estimated savings in cost of satisfying a market of a given size
during the years 1993 to 2007. For this example, both the Requirements Tool and the Design
Tool are being considered, with the Requirements Tool adoption to start in 1993 and the Design
Tool adoption to start in 1995. To determine the estimated change in market cost savings due
to the phased adoption of two technologies during the years 1993 to 2007:

1. Follow the instructions for Set Model Parameters to set Baseline unit labor rate to an
appropriate value, Percent annual labor rate decrease not due to technology to an
appropriate value, Baseline unit labor cost, Percent annual wage increase, Baseline
market size, and Market size annual percent growth rate. For our example:

- Baseline unit labor rate-= 10

- Percent annual labor rate decrease not due to technology= 3

- Baseline unit labor cost = 10

- Percent annual wage increase= 4

- Baseline market size = 10,000

- Market size annual percent growth rate =4
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2. Follow the instructions for Set Technology Status to set the status of the technologies
in question to enabled and set the status of the other technologies to disabled. For our
example:

- Requirements Tool status = enabled

- Design Tool status = enabled

- Other technologies status = disabled

3. Follow the instructions for Set Technology Start/End to set the start and end years of
the technologies in question (e.g., Requirements Tool and Design Tool) to appropriate
values. For our example:

- Requirements Tool start year = 1993

- Requirements Tool end year = 2007

- Design Tool start year = 1995

- Design Tool end year = 2007

4. Follow the instructions for Set Coverage Values to set the coverage for the activities
(see Table 4-5).

5. Follow the instructions for Set Extent Values to set the extent of use for the technologies
in question (see Table 4-6).

6. Follow the instructions for Set Impact Values to set the impact for each activity upon
which the technologies in question have an effect (see Table 4-7).

7. Select Market Cost Savings vs Time from the Graphs menu and interpret output
(shown in Figure 4-22) as labeled.

4.4 CALCULATION OF RETURN ON INVESTMENT AND BREAK EVEN

You may wish to estimate the ROI in introducing a new technology into your software development
process. Here, the return is defined as the savings or reduction in development cost your organization
would expect to realize by investing in some technology or set of technologies. The ROI is calculated
with respect to the cost of introducing that technology. It is important to realize that there can be other
valuable results from investing in new technology that are not covered by the ROI calculation defined
here, which is based solely on reductions in development costs. Some other valuable benefits of an
investment in new technology can be an increase in quality (indicated by reduction in defects in a
software product), reduction in time required (schedule) to develop a product, etc.

The Technology Benefits Model tool can provide you some of the data that you need to compute the
ROI, such as the market cost or product cost savings on a yearly basis that the use of one or more
technologies can provide to you. To calculate the ROI, you will also need to know the cost of introduc-
ing and using the technology of interest on a yearly basis. Then, you insert the sets of values for savings
and investment costs into the formula given below and calculate the ROI.
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Now, we consider how you can calculate the ROI. You can use the data on savings that arc tvailable
toyou from the spreadsheet in the tool, an example of which is shown in Figure 4-3 as Product Develop-
ment Cost Savings (K$) vs Time or in Figure 4-4 as Market Cost Savings (K$) vs Time, yearly, over
the period of years covered in the analysis. You will also have to provide values for the investment
costs on a yearly basis to calculate the ROI. The ROI is related to both the net present value (NPV)
of the savings that your organization would derive from the use of a new technology and the NPV of
the investment required to realize that savings. The NPV of the savings is the present worth (or worth
today) of the stream of savings that results from the stream of investments (costs) in introducing the
new technology into your organization. Similarly, the NPV of the costs (investment) required to realize
that savings is the present value of the stream of yearly costs. The ROI measure is the ratio of the
NPV of the savings to the NPV of the costs. If you invested in technology X and you calculated an
ROI of 500, this would mean that for every dollar (NPV) of investment, you would derive a benefit
or return of $5 (NPV). Whether this will be sufficient to justify the investment depends upon the
investment goals of your organization.

The ROI in percent is given by the expression:

ROI = (SUMS)/ (SUMC) • 100

where:

Y S
SUMS = •"(1 + i)tt=l

SUMC Y CtSU C 1-• (1 + i)t
t=l

St = The savings in dollars realized in year t (for product development cost or market

cost). You obtain these values from the spreadsheet; they are calculated by the tool.
Note that these figures can be positive (i.e., a savings was realized) or negative (i.e.,
the investment resulted in the product costing more or the market costing more to
realize than if the technology had not been employed).

Ct= The investment in dollars made in year t to introduce the technology into your
development process. You must provide the Ct figures based on an analysis of the
investment, required on a yearly basis, of inserting the new technology into your
development process.

t = A variable for a particular year.

i = The discount rate or cost of money.

v = The number of years during which the calculations are made. The maximum value
of y is 15 if you use savings data from the Technology Benefits Model tool.

Consider this example of the calculation of ROI. The example is based on the scenario described
in Section 4.3.3, in which two technologies are introduced, the first in 1993 and the second in 1995.
Consider the effect on a market that begins in 1993 at 10,000 KSLOC and grows at 4% per year.
The cost of money (i) is 8% in this example. Calculate the ROI based on market cost savings for
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1 year, 2 years, through 8 years. Develop a table of data like Table 4-10. Perform the following steps
to compute the ROI:

Table 4-10. Sample Return on Investment Calculations

Year, t St SUMS Ct SUMC ROI
1, 1993 4,820 4,463 4,000 3,704 121
2, 1994 13,183 15,765 3,000 6,276 251

3, 1995 -2,064 14,126 6,000 11,039 128
4, 1996 -9,675 7,015 4,000 13,979 50
5, 1997 -8,143 1,473 3,000 16,021 9
6,1998 3,968 3,974 2,000 17,281 23
7, 1999 27,974 20,296 2,000 18,448 110

8, 2000 65,025 55,429 2,000 19,529 284

1. Obtain the savings expected to be realized by the use of the proposed technology. The values
of the savings in year t, St, are taken from the row in the spreadsheet (see Figure 4-4) under
Market Cost Savings (K$) vs Time labeled Savings due to use of technology, with 100% extent
of use.

2. Estimate the investment cost per year, Ct for year t, over the chosen period of years.

3. Calculate the SUMS values, the NPV of the savings, using the formula given above.

4. Calculate the SUMC values, the NPV of the investment, using the formula given above.

5. Calculate the ROI values from the SUMS and the SUMC values using the formula given above.
All of the ROI figures are the NPV at year 1. The ROI figure shown for year 1 is based on
the year 1 costs and savings only. The ROI for year 2 is hased on the savings and the costs
for years 1 and 2. Similarly, the ROI for year 8 is based on the savings and costs for years 1
through 8.

You can locate the break-even point based on your calculation of the ROI. The break-even point is
the time at which the total savings are equal to the total cost. Thus, the break-even point is when ROI
is equal to 100. Whenever the ROI is greater than 100, your investment in new technology is paying
off. Whenever the ROI is less than 100, the investment is not paying off or is not breaking even. If
the data for years 4, 5, or 6 is included, the corresponding ROIs are below 100%, meaning that the
investment would not be a break-even situation. This is due to the peculiarities of the hypothetical
investment cost structure used. There is a better than break-even situation if year 1 alone, years 1 and
2, or years 1, 2, and 3 are considered. However, if more years are considered, you would not break
even again until the seventh year is considered. This economic analysis suggests various alternative
decisions that you might make concerning the possible technology investment that you are consider-
ing. One decision would be to not introduce the second technology in 1995. Another would be to intro-
duce the second technology in 1995 and to recognize, over the long run. that there will be a significant
ROI if your planning horizon is 7 or 8 years.
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5.1 OVERVIEW

This section presents three case studies of the application of the Technology Benefits Model tool.
They were conducted by three different Software Productivity Consortium member company
organizations.

5.2 CASE STUDY A

Case Study A investigated the result of introducing a new requirements technology for the
development of embedded software products coded in Ada. The period considered was 3 years,
from 1993 through 1995. The effect of using the technology was determined for the product devel-
opment costs for two sizes of product: 18 KSLOC and 114 KSLOC. The analyst selected the values
of the model parameters given in Table 5-1, following the procedure outlined in Section 4.3.2.4,
using a dialog boxwith the format depicted in Figure 4-11. He chose 14.29 LM/KSLOC for thevalue
of the Baseline unit labor rate parameter, based on the experience of his organization. Also, based
on organizational experience, he selected the values of the coverage parameters or the percent of
effort (the percent of the 14.29 LM/KSLOC in this case) in each of the development activities. Table
5-2 lists those activities and provides the values of the coverage parameters for each of them.

The analyst wanted to obtain the number of labor months, not the number of dollars required, for
development. The tool does not provide a graph or spreadsheet entry with this information. To
obtain it, he proceeded as follows, setting the values of certain model parameters and interpreting
the outputs of the tool as indicated. This practical example of applying the tool slightly differently
than the situations for which it was designed suggests other uses for the tool and interpretations
of its outputs that might help you in situations that the tool developers may not have foreseen. The
analyst used the Technology Benefits Model tool to obtain the labor months required to develop
an 18-KSLOC product by using the Product Development Cost vs Time graph. He set the Baseline
unit labor cost parameter to 1 and the Percent annual wage increase parameter to 0. Then, the
spreadsheet entry labeled "Product Development Cost (K$) vs Time" (see Figures 5-1 and 5-2) is
numerically equal to and can be interpreted as "Product Development Labor Months vs Time"
for the 18-KSLOC product. Similarly, the spreadsheet entry labeled "Product Development Cost
Savings (K$) vs Time" is numerically equal to and can be interpreted as "Product Development
Labor Months Savings vs Time" for the 18-KSLOC product. This usage and interpretation of the
Product Development Cost vs Time graph is also noted in Table 2-2.

The analyst wanted to obtain the development cost for both the 18-KSLOC product and the
114-KSLOC product with one run of the tool. He obtained the data for the 18-KSLOC product
as described in the preceding paragraph. He obtained the data for the 114-KSLOC product using
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Figure 5-1. Spreadsheet for Case Study A Impact Values Set 1

the Market Cost vs Time and the Market Cost Savings vs Time graphs and correspon~ing spread-
sheet entries (see Figures 5-1 and 5-2) to obtain the data he desired. He set the Baseline market
size parameter equal to 114, the size of the second product. Also, he set the Market size annual
percent growth rate parameter equal to 0. Then, the spreadsheet entry labeled "Market Cost (K$)
vs Time" (see Figures 5-1 and 5-2) is numerically equal to and can be interpreted as "Product Devel-
opment Labor Months vs Time" for the 114-KSLOC product. Similarly, the spreadsheet entry la-
beled "Market Cost Savings (K$) vs Time" is numerically equal to and can be interpreted as
"Product Development Labor Months Savings vs Time" for the 114-KSLOC product. This usage
and interpretation of the Market Cost vs Time graph is also described in Table 2-2.
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Figure 5-2. Spreadsheet for Case Study :\ Impact Values Set 2

"lhble 5-1. Case Study A Model Parameter Values

Parameter Name Parameter Value

Baseline unit labor rate (LM/KSLOC) 14.29

Baseline unit labor cost (KS'LM) I

Percent annual wage increase 0

Percent annual labor rate decrease not due to technology 0

Siue of product in KSLOC Is
Baseline market siue (KSLOC) 114
Market size annual percent growth rate 0

First year 1993
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Table 5-2. Case Study A Coverage Values

Activity Coverage (%)

I Planning 3

Requirements Analysis 9

Preliminary Design 10

Detailed Design 20

Coding and CSU Testing 28

CSC Integration and Testing 23

CSCI Testing 7

The analyst selected the values of the impact parameter to reflect a learning curve in the application
of the new requirements technology. Because he was somewhat uncertain of the effect of the new tech-
nology on the development costs, the analyst selected two different sets of values for the impact param-
eter. Table 5-3 presents the two sets of values he used in the analysis. He conducted two runs of the
tool, each using a different one of the two sets of impact parameter values. The extent parameter was
set to 100 because the analyst was principally interested in estimating the situation in which the entire
organization doing each of these developments would use the new technology (as appropriate to the
development process).

Table 5-3. Case Study A Impact Values

Impact Values Set 1 (%) Impact Values Set 2 (%)

Activity 1993 1995 1993 1995

Planning -_10 0 -_10 0

Requirements Analysis -10 5 -10 5

Preliminary Design -5 5 -2.5 5

Detailed Design 0 0 2.5 5

Coding and CSU Testing 5 7.5 5 7.5

CSC Integration and Testing 5 10 2.5 5

CSCI Testing 0 0 0 2.5

The principal results of the analysis are summarized in Table 5-4. It shows the labor months expected
to be saved by using the new requirements technology for the 18-KSLOC and 114-KSLOC products
if each of them were built in 1993, 1994, or 1995. Two sets of valucs are shown, each of which corre-
sponds to one of the sets of impact parameter values (see Table 5-3) used in the analysis. The savings
for the 18-KSLOC product are taken from the row labeled "Product Development Cost Savings (K$)
vs Time, With application of technology, with user-entered extent of use" on the spreadsheets shown
in Figures 5-1 and 5-2 for Impact Valus Set 1 and Impact Values Set 2 respectively. The savings for
the 114-KSLOC product are taken from the row labeled "Market Cost Savings (K$) vs Time, Savings
due to use of technology, with user-entered extent of use" on the spreadsheets shown in Figures 5-1
and 5-2 for Impact Values Set 1 and Impact Values Set 2, respectively. The percent savings are identic-.
for the 18-KSLOC and the 1 14-KSLOC products. The savings are comnputed relative to the row labeled
"Product Development Cost (K$) vs Time, Without application of technology" if you use the
18-KSLOC product data or relative to the row labeled "Market Cost (K$) vs Time, Without application
of technology" if you use the 114-KSLOC data.
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Table 5-4 shows that the two sets of values for the estimated absolute amount or percent of savings
do not differ appreciably based on the estimated impact values used. Therefore, assuming that the
ranges given in Table 5-3 (the analyst's estimates) for these values cover the range of uncertainty, then
either set of expected savings or the average of the two could be used as the estimated savings.

Table 5-4. Labor Months Savings Resulting From Use of New Technology, Case Study A

Impact Values Set I Impact Values Set 2

18-KSLOC 114.KSLOC 18.KSLOC 114-KSLOC
Product Product Product Product

Development Development Development Development
Cost (LM) Cost (LM) Percent Cost (LM) Cost (LM) Percent

Year Savings Savings Savings Savings Savings Savings

1993 2.19 13.85 0.85 2.64 16.70 1.03
1994 10.09 63.92 3.92 10.78 68.29 4.19

1995 23.31 147.65 9.06 24.03 152.18 9.34

5.3 CASE STUDY B

Case Study B investigated the result of introducing an automatic code generator into an organization
that develops control system software. An 11-year period was considered in the analysis, from 1991
through 2001. The effect of using the technology was determined for the product development costs
for two sizes of product: 36.38 KSLOC and 60 KSLOC. The analyst selected the values of the model
parameters given in Table 5-5, following the procedure outlined in Section 4.3.2.4, using a dialog box
with the format depicted in Figure 4-11. She chose 0.52 LM/KSLOC for the value of the Baseline unit
labor rate parameter, based on the experience of the development organization in creating a software
product in 1991, the first year (see the values of the model parameters in Table 5-5) of the period ana-
lyzed. This relatively low value of unit labor rate was partly due to the high degree of reuse of existing
software in the composition of this new software product. Also, based on organizational experience,
the analyst selected the values of the coverage parameters or the percent of effort in each of the devel-
opment activities. Table 5-6 lists those activities and provides the values of the coverage parameters
for each of them.

Table 5-5. Case Study B Model Parameter Values

Parameter Name Parameter Value

Baseline unit labor rate (LM/KSLOC) 0.52

Baseline unit labor cost (K$/LM) 1

Percent annual wage increase 0

Percent annual labor rate decrease not due to technology 0

Size of product in KSLOC 36.38

Baseline market size (KSLOC) 60

Market size annual percent growth rate 0
First year 1991
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Table 5-6. Case Study B Coverage Values

Activity Coverage (%)

Requirements Review 11.8

Detailed Design 27.9

Code 28.2

Code Read 12.1

Unit Test 0.4

Integration Test 19.6

As in Case Study A, the analyst for Case Study B wanted to obtain the number of LMs, not the number
of dollars required, for development. As noted in Section 5.2, the Technology Benefits Model tool does
not provide a graph or spreadsheet entry with this information. To obtain it, the analyst proceeded
as follows, setting the values of certain model parameters and interpreting the outputs of the tool as
indicated. This is another practical example of applying the tool slightly differently than the situations
for which it was designed. The analyst used the Technology Benefits Model tool to obtain the labor
months required to develop a 36.38-KSLOC product by using the Product Development Cost vs Time
graph. She set the Baseline unit labor cost parameter to 1 and the Percent annual wage increase pa-
rameter to 0. Then, the spreadsheet entry labeled "Product Development Cost (K$) vs Time" (see Fig-
ures 5-3 and 5-4 ) is numerically equal to and can be interpreted as "Product Development Labor
Months vs Time" for the 18-KSLOC product. Similarly, the spreadsheet entry labeled "Product Devel-
opment Cost Savings (KS) vs Time" is numerically equal to and can be interpreted as "Product Devel-
opment Labor Months Savings vs Time" for the 36.38-KSLOC product. This usage and interpretation
of the Product Development Cost vs Time graph is also noted in Table 2-2.

The analyst wanted to obtain the development cost for both the 36.38-KSLOC product and the
60-KSLOC product with one run of the tool. She obtained the data for the 36.38-KSLOC pioduct as
described in the preceding paragraph. She obtained the data for the 60-KSLOC product using the
Market Cost vs Time and the Market Cost Savings vs Time graphs and corresponding spreadsheet
entries (see Figures 5-3 and 5-4) to obtain the data she desired. She set the Baseline market size param-
eter equal to 60, the size of the second product. Also, she set the Market size annual percent growth
rate parameter equal to 0. Then, the spreadsheet entry labeled "Market Cost (K$) vs Time" (see Fig-
ures 5-3 and 5-4) is numerically equal to and can be interpreted as "Product Development Labor
Months vs Time" for the 60-KSLOC product. Similarly, the spreadsheet entry labeled "Market Cost
Savings (K$) vs Time" is numerically equal to and can be interpreted as "Product Development Labor
Months Savings vs Time" for the 60-KSLOC product. This usage and interpretation of the Market
Cost vs Time graph is also described in Table 2-2.

The analyst selected the values of the impact parameter to reflect changes expected in the costs of
the various development activities over the period of time analyzed attributable to the use of the code
generator. Table 5-7 presents the set of values she used in the analysis. The selections reflect the view
of the analyst that using the code generator would eventually cause very significant reductions in the
effort spent in the code, code read (verification), and unit test activities. She expects that the generator
will not affect the the integration test activity at all. She also apparently believes that using the genera-
tor will result in some increase in the effort to perform detailed design and some reduction in the soft-
ware development organization's effort of requirements review provided to it.
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Figure 5-3. Spreadsheet for Case Study B (part 1)

Table 5-7. Case Study B Impact Values

Impact Values()

Activity 1991 2001

Requirements Review 0 5
Detailed Design 0 -5

Code 0 50

Code Read 0 70
Unit Test 0 98
Integration Test 0 0

The values selected for the extent parameter, shown in Table 5-8, reflect the analyst's estimate that
only a very small proportion of the organization that develops the control system software was using
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Figure 5-4. Spreadsheet for Case Study B (part 2)

the code generator in 1991, the first of the 11-year period analyzed here. However, by 2001, she believes
that the entire development organization will use it. Thus, in this use of the Technology Benefits Model
tool, the baseline situation was one having a very modest use of the new technology (the generator).
The tool user should note that the baseline situation can be some degree of use of a new technology.
That is, your baseline situation need not be without use of the new technology of interest. Also, the
analyst apparently believed that using the code generator would cause no impact (see Table 5-7) on
the cost of software development during the first year (1991) but that impact would increase incremen-
tally to be very substantial for some of the development activities.
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Thble 5-8. Case Study B Extent Values

Year Extent (%)

1991 3

2001 100

The principal results of the analysis are summarized in Table 5-9. It shows the labor months expected
to be saved by using the new requirements technology for the 36.38-KSLOC and 60-KSLOC products
if each of them were built in any year from 1991 through 2002. Note from Tables 5-7 and 5-8 that the
code generator is introduced into the development organization during the period 1991 through 2001.
After 2001, the development cost and percent savings remain constant for products of the two sizes
considered in this analysis. Remember that the savings are for the new technology (the code generator)
if it had not been introduced into the development process. Thus, the total savings would continue
to grow annually as more unique software systems are developed. Also, Table 5-9 shows the percent
savings in the development effort. The savings are for the code generator if it would not be used. The
savings for the 36.38-KSLOC product are taken from the row labeled "Product Development Cost
Savings (K$) vs Time, With application of technology, with user-entered extent of use" on the spread-
sheets shown in Figures 5-3 and 5-4. The savings for the 60-KSLOC product are taken from the row
labeled "Market Cost Savings (K$) vs Time, Savings due to use of technology, with user-entered extent
of use" on the spreadsheets shown in Figures 5-3 and 5-4. The percent savings are identical for the
36.38-KSLOC and the 60-KSLOC products. The savings are computed for the row labeled "Product
Development Cost (K$)vs Time, Without application of technology" if you consider the 36.38-KSLOC
product data or for the row labeled "Market Cost (K$) vs Time, Without application of technology"
if you consider the 60-KSLOC data.

Table 5-9. Labor Months Savings Resulting From Use of New Technology, Case Study B

36.38-KSLOC 60-KSLOC
Product Product

Development Development
Cost (LM) Cost (LM) Percent

Year Savings Savings Savings

1991 0.00 0.00 0.00

1992 0.05 0.09 0.29

1993 0.24 0.40 1.28

1994 0.64 1.05 3.37

1995 1.32 2.17 6.96

1996 2.32 3.83 12.28
1997 3.67 6.05 19.39

1998 5.35 8.82 28.27

1999 7.29 12.02 38.53

2000 9.38 15.47 49.58

2001 11.49 18.96 60.77

2002 11.49 18.96 60.77
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5.4 CASE STUDY C

Case Study C investigated the result of introducing a new requirements technology into an
organization that develops control software for coordinated transport systems. The new technology
will improve the requirements gathering process. An 8-year period was considered in the analysis,
from 1993 through 2000. The effect of using the technology was determined for the product develop-
ment costs for a 20-KSLOC product and a Baseline market size of 60 KSLOC. The analyst selected
the values of the model parameters given in Table 5-10, following the procedure outlined in Section
4.3.2.4, using a dialog box with the format depicted in Figure 4-11. He chose 2.4 LM/KSLOC for the
value of the Baseline unit labor rate parameter, based on the experience of his development organiza-
tion. The figure represents his organization, which does a significant amount of reuse in the composi-
tion of new software systems. Table 5-11 lists the software development activities and provides the
values of the coverage parameter for each of them. These values were estimated by the analyst and
were not based on specific data from his organization.

Thble 5-10. Case Study C Model Parameter Values

Parameter Name Parameter Value

Baseline unit labor rate (LM/KSLOC) 2.4
Baseline unit labor cost (K$/LM) 15
Percent annual wage increase 3.5
Percent annual labor rate decrease not due to technology 3.0
Size of product in KSLOC 20
Baseline market size (KSLOC) 60
Market size annual percent growth rate 25
First year 1993

Unlike the analysts in Case Studies A and B, the analyst for Case Study C wanted to consider the
effect of the new technology on both a product of a particular size and a market that he anticipates
will grow at a significant rate. The analyst set the model parameter values as shown in Table 5-10. He
set the Baseline unit labor cost parameter to 15 and the Percent annual wage increase parameter to
3.5, indicating a 3.5% rate of growth for the initial $15K LM cost. The Percent annual labor rate de-
crease not due to technology was set to 3% to cover improvements in the productivity of the develop-
ment organization due to various factors including the general maturation of the organization. The
Baseline market size parameter was set to 60. The rate of growth of this market (the Market size annu-
al percent growth rate parameter) was set to 25. This means that the market would grow almost 6
times in the 8-year period analyzed.

Table 5-11. Case Study C Coverage Values

Activity Coverage (%)

Requirements Gathering 5

Design 10

Code 25

Integration 30
System Test 30
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The analyst selected the values of the impact parameter to reflect changes expected in the costs of
the various development activities over the period of time analyzed attributable to the use of the new
requirements gathering process. Table 5-12 presents the set of values he used in the analysis. The selec-
tions reflect the view of the analyst that using the new process would eventually cause very significant
reductions in the effort spent in the requirements gathering, integration, and system test activities.
However, he expects the new technology to initially cause the cost of requirements gathering to rise
significantly due in part to the unfamiliarity of the development organization with it. He expects that
initial situation to reverse itself. He also expects that there will be a significant payoff from using the
new technology for the later development activities after a period of time.

Thble 5-12. Case Study C Impact Values

laipact Values (%)

Activity 1993 2000

Requirements Gathering -75 80
Design 0 -5
Code 0 0
Integration 0 50
System Test 0 50

The values selected for the extent parameter, shown in Table 5-13, reflect the analyst's view that the
new technology will eventually be used by the entire development organization, increasing from a
relatively low degree of usage.

Table 5-13. Case Study C Extent Values

Year Extent (%)

1993 11

2000 100

The principal results of the analysis are summarized in Table 5-14. It shows the thousands of dollars
expected to be saved by using the new technology for the 20-KSLOC product and for the market
that is expected to grow from the initial 60-KSLOC figure at an annual compounded rate of 25%.
There is a slight loss (negative savings) in both 1993 and 1994. This is due to the initially negative
impact of using the new technology (see Table 5-12). Table 5-14 also provides percent savings for
product development cost and market cost. These two figures are always identical, which can be
verified from the mathematical models that underlie the tool (see Appendix A). After 2000, when
the introduction of the new technology into the development organization has been completed, the
percent savings will remain constant. However, the cost savings will continue to increase. The sav-
ings for the 20-KSLOC product are taken from the row labeled "Product Development Cost Sav-
ings (K$) vs Time, With application of technology, with user-entered extent of use" on the
spreadsheets shown in Figures 5-5 and 5-6. The savings for the market (initially of 60 KSLOC) are
tak,,, l'uni the iow lab,,!cd "Market Cost Savings (K$) vs Time, Savings due to use of technology.
with user-entered extent of use" on the spreadsheets shown in Figures 5-5 and 5-6. The percent
savings are identical for the product and the market. The savings are computed for the row labeled
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cost data or for the row labeled "Market Cost (K$) vs Time, Without application of technology" if you
consider the market cost data.

Tkble 5-14. Labor Months Savings Resulting From Use of New Technology, Case C

Development Cost Development Cost Market Cost Percent Market
Year Savings (K$) Savings Savings (KS)* Cost Savings"

1993 -. 7-41-8.91 -0.41

1994 -. 8-03-1.04 -0.03

1995 179 .784.15 2.47

1996 60.67 8.32 355.50 8.32

1997 133.64 18.27 978.84 18.27
1998 236.47 32.20 2,164.94 32.20

1999 360.34 48.88 4,123.78 48.88
2000 488.52 1 66.00 6,988.36 66.00

2001 490.45 66.00 8,769.96 66.00
2002 492.39 66.00 11,005.75 66.00

4` Note: For a market of 60 KSLOC in 1993 growing at 25% annually to approximately 6 times the
original size to 357.6 KSLOC

SNote: The percent Market Cost Savings is always equal to the percent Product Development Cost
Savings.
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._ 1- . . ; : ; . ; :: ;Y : T i.ýizii

Figure 5-5. Spreadsheet for Case Study C (part 1)

5-12
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Grfta tAls

11 Product Development Cost (KV) vs Tiue 1 998i 1999: 2000i 2001 i 20021 _

12 Without appiatin of tchn•ology 734.331 737.231 740.1SI 743.07i1 746.00
With appl1atim of tecmology, with user-entered extent

13 of use 497.86; 376-89 251 .62: 252.62: 253.62
With applcation of techn~ology, with I WS extent of use

14 (the ideal situation) 389.92,. 281.15: 187.701 188.44: 189.19:

Product Developm-ent Cost Savings (KS) vs - '_ 4-

16 Time 1998! 1999i 2000: 2001: 2002t
With application of technology, with user-entered extent

1 oofuse 236.47 36034. 488.52. 490.45 492.39.
With application of techvoloq9 with 100 extent of use

18 (theidealsituation) 344.42. 456.081 S52.44; 5462 55682

19 _____ ___ __ _______
........ ... ......

20 market Cost (K$) vs Time 1998; 1999: 2000: 2001: 2002:'
21 Withutap.licationoftec.hno ." 6,723.02i 8,436.97z 1058787.1 13,287.11 1667449

With application of technolg-j, with user-entered extent
22 of use 4 ,~9 313.19 i 3599.0 4,517.1S! 5668.741

With application of technology, with 100% extent of use
23 (the ideal situation) 3 .569.781 3 217.50! 2.685.11 313 369.64 4,228.69 :

-- .. ............ .... .... ......

25 Market Cost Sa.,ings, S)vsTime 1998! 1999i 2000i 2001: 2002:
Savings due to use of technology, with user-entered

26 extentofuse 2 164 94i 4,123.781 6,98836 8,769.96i 110575
Sav i-g ue ose of tenchnology4 wth 1 0O- xtent of

27 use (the ide1 situation) 3 1 S3 23 _521947. 7902.76 9_ 97.47i 12 045 03 .. .. .: ..:: : : :: : : : : : .:: : : - .. . . . . . . . . . . . . . . . . . . . . . .

Figure 5-6. Spreadsheet fo-' Case Study C (part 2)
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APPENDIX A. TECHNOLOGY BENEFITS
MATHEMATICAL MODELS

A.1 OVERVIEW

This section presents the mathematical models implemented in the Technology Benefits Model tool.
The tool provides five graphs, the equations for which are presented in Sections A.3 through A.7. They
are:

1. Unit Labor Rate vs Time

2. Unit Labor Cost vs Time

3. Product Development Cost vs Time

4. Market Cost vs Time

5. Market Cost Savings vs Time

Each of the first four graphs consists of three curves:

1. Without application of technology

2. With application of technology, with user-entered extent of use

3. With application of technology, with 100% extent of use (the ideal situation)

The fifth graph, Market Cost Savings, consists of two curves:

1. Savings due to use of technology, with user-entered extent of use

2. Savings due to use of technology, with 100% extent of use (the ideal situation)

In addition, the tool calculates two sets of values of Product Development Cost Savings:

1. Savings due to use of technology, with user-entered extent of use

2. Savings due to use of technology, with 100% extent of use (the ideal situation)

This data is not plotted. It is available to you in the spreadsheet. The equations for it are presented
in Section A.S.

A.2 MODEL PARAMETERS

Table A-1 names the parameters of the model equations that you can input. Table A-2 names other
parameters of the model equations that are internal to them, which you cannot input. The model equa-
tions are provided in Sections A.3 through A.8.
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Appendix A. Technology Benefits Mathematical Modtis

Table A-i. Model Input Parameters

Input Parameter
Symbol Input Parameter Description

L Baseline (first year) unit labor rate (LM/KSLOC)

C Baseline (first year) unit labor cost (K$/LM)

pw Percent annual wage increase

ac Percent annual labor rate decrease not due to technology whose impact is being
modeled

S Size of product in KSLOC

M Baseline market size in KSLOC

pm Market size annual percent growth rate

CP Coverage, percent of development process to which the indicated activity applies.
This parameter is approximated as being constant in time for each activity "p."
That is, it does not include the effect of changing the marginal cost impact effect.

Eky Extent, percent of user organization applying technology "k" in year "y." For
100% extent of use, Ek,= 100.

Ikpy Impact, percent unit net cost reduction (net savings) due to applying a technology
"k" on activity "p" in year "y." A positive value of Ikpy, between 0 and 100, is used
to indicate a net savings. A negative value of IkM, between 0 and 100, is used to
indicate a net cost.

Thble A-2. Model Internal Parameters

Internal Parameter
Symbol Internal Parameter Description

y Year index (y=l, ... , m) where y= 1 corresponds to the first year and y=m corre-
sponds to the last year

P Number of activities (e.g., currently P = 12)

p Activity index (p = 1, ... , P) where p = 1 corresponds to a particular activity (e.g.,
Requirements Analysis)

T Number of technologies (e.g., maximum value K = 9)

k Technology index (k=1 ... , K) where k = 1 corresponds to a particular technology

A.3 GRAPH 1 EQUATIONS, UNIT LABOR RATE

1. Unit labor rate (LM/KSLOC), without application of technology

AAy = L-[1-0.01 .acjY-t
2. Unit labor rate (LM/KSLOC), with application of technology, with user-entered extent of use

ADy = mA y-. 1-0.000001 - I Y Ikpj "Cp'Ekj
k-lp=l

ADy AAy' - A -ETi
jA1
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Appendix A. Technology Benefits Matbematical Models

where:

K P
RET1 = 0.000001. Z kpj .Cp. Ek

k=lp=l

The value 0.000001 is a constant used to scale the product of impact, coverage, and extent
values to a result less than or equal to 1.

3. Unit labor rate (LM/KSLOC). with application of technology, with 100% extent of use

= I k =lp=l P

AEy = AAY. [I[1- RTj]J=l1

where:

K n
RTFj = 0.0001 1 Y Ikpj -Cp

k=lp=l

The value 0.0001 is a constant used to scale the product of impact and coverage values to a
result less than or equal to 1.

A.4 GRAPH 2 EQUATIONS, UNIT LABOR COST

1. Unit labor cost (K$/KSLOC), without application of technology

BAY- = C-[1 + 0.01 - pw 'l - AAy

2. Unit labor cost (K$/KSLOC), with application of technology, with user-entered extent of use

BDy = BAy. JjI[1- RETj]

3. Unit labor cost (K$/KSLOC), with application of technology, with 100% extent of use

BEY = BAy .1-1[1 - RT-r]

A.5 GRAPH 3 EQUATIONS, PRODUCT DEVELOPMENT COST

1. Labor cost (K$), without application of technology

CAy = S -BAY

2. Labor cost (K$). with application of technology, with user-entered extent of use

CDy = S • BDy
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Appendix A. Technology Benefits Mathematical Models

3. Labor cost (KS), with application of technology, with 100% extent of use

CEy = S • BEY

A.6 GRAPH 4 EQUATIONS, MARKET COST

1. Labor cost (KS), without application of technology

DAy = M -[I + 0.01 .pm]Y- 1 .BAy

2. Labor cost (KS:, with application of technology, with user-entered extent of use

DDy = M .[1 + 0.01 . pm]y- . BDy

3. Labor cost (KS), with apolication of technology, with 100% extent of use

DEy = M .[1 + 0.01 .pm]y- 1 .BEy

A.7 GRAPH 5 EQUATIONS, MARKET COST SAVINGS

1. Labor cost savings (KS) telative to baseline du'e to application of technology, with user-entered
extent of use. Bast':Tne labor cost, without application of technology, is DAy=M •(1I+ 0.01(,--n))Y • BAY,

EDy = DAY - DDy

2. Labor cost savings (FS) relative to baseline due to application of technology, with 100% extent
of use. Baseline labor cost, without application of technology, is DAY = M • (1 + 0.01(pm))Y
- BAY.

EEy = DAY - DEy

A.8 ADDITIONAL DATA EQUATIONS, PRODUCT COST SAVINGS

In addition to the data calculated by the tool and presented in graphical form as described in Section
A.3 through Section A.7, the tool also calculates two other sets of values related to Product Cost Szv-
ings that are not presented in graphical form but are available on the spreadsheet. They are:

1. Savings (KS) due to use of technology, with user-entered extent of use

FDy = CAy - CDy

2. Savings (KS) due to use of technology, with 100% extent of use

FEy = CA,,- CEy
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LIST OF ABBREVIATIONS AND ACRONYMS

CASE computer-aided software engineering

CSC computer software component

CSCI computer software configuration item

CSU computer software unit

KSLOC thousands of source lines of code

K$ thousands of dollars

LM labor months

NPV net present value

PC personal computer

RAM random access memory

ROI return on investment

Abb-1
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GLOSSARY

Baselire Market Size The number of KSLOC in the market.

Baseline Unit Labor Cost The number of K$/LM in the first year.

Baseline Unit Labor Rate The number of LM/KSLOC in the first year.

Coverage The percent of development cycle labor to which a
particular capability is applicable.

Extent The percent of customer development organizations
using a particular capability.

Impact The net percent of development labor reduction (or
savings) in a portion of a development cycle due to
the use of a particular capability.

Size of Product The number of KSLOC in the product.
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INDEX

Activities menu, set activity names, 4-8 product development cost vs time, 4-27
unit labor cost vs time, 4-25
unit labor rate vs time, 4-22

Configuration
Macintosh, 3-1
PC, 3-2

Coverage, 2-2 Impact, 2-2
Input parameter, 2-4

baseline market size, 2-4
Extent, 2-2 baseline unit labor cost, 2-4

baseline unit labor rate, 2-4
coverage, 2-4
extent, 2-5

File menu, 4-7 first year, 2-4
close, 4-7 impact, 2-5
print all, 4-7 market size annual percent growth rate, 2-4
print coverage, 4-7 percent annual labor rate decrease not due to
print extent, 4-7 technology, 2-4
print graph data, 4-7 percent annual wage increase, 2-4
print impact, 4-7 size of product, 2-4
print model parameters, 4-7 Installation, Macintosh, 3-1, 3-3
save, 4-7 Interpolation

extent, 2-5
impact, 2-5

Graphs, 2-3 Invoking the Technology Benefits Model
curves, 2-3 from a diskette

savings due to use of technology Macintosh, 3-2
with 100% extent of use, 2-4 PC, 3-3
with user-entered extent of use, 2-4 from a hard disk

with application of technology Macintosh, 3-2
with 100% extent of use, 2-3 PC, 3-4
with user-entered extent of use, 2-3

without application of technology, 2-3
generating, 4-19
market cost savings vs time, 2-6 Main window
market cost vs time, 2-6 menu bar, 4-3
product development cost vs time, 2-6 worksheet, 4-3
unit labor cost vs time, 2-5 intermediate results, 4-7
unit labor rate vs time, 2-5 labor cost vs time, 4-4

Graphs menu, 4-19 labor rate vs time, 4-3
market cost savings vs time, 4-32 market cost savings vs time, 4-5
market cost vs time, 4-31 market cost vs time, 4-5
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Index

product development cost savings vs time, Technologies menu, 4-9
4-5 set technology names, 4-9

product development cost vs time, 4-4 set technology start/end, 4-10
set technology status, 4-11

Parameters menu, 4-12
set coverage values, 4-14 User interface, 4-1
set extent values, 4-16 menu bars, 4-1

set impact values, 4-17 selecting

set model parameters, 4-12 from menus, 4-1
from worksheet, 4-1

windows
activating, 4-1

Return on investment, 4-34, 4-35 closing, 4-1
net present value, 4-35 scrolling, 4-2

of the investment, 4-35 sizing, 4-2
of the saviugs, 4-35

to compute ROI, 4-36

Window menu, arrange all, 4-20
Worksheet

Start window, 4-2 intermediate results, 4-7
Consortium logo, 4-2 labor cost vs time, 4-4
menu bar, 4-2 labor rate vs time, 4-3

Startup menu, 4-2 market cost savings vs time, 4-5
begin, 4-3 market cost vs time, 4-5
end, 4-3 product development cost savings vs time, 4-5

product development cost vs time, 4-4

Ind-2


